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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections
of the other component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this product and certified for the country
of use.

Connect and Disconnect Properly. Do not connect or disconnect probes or test leads while they are
connected to a voltage source.

Connect and Disconnect Properly. Connect the probe output to the measurement instrument before
connecting the probe to the circuit under test. Connect the probe reference lead to the circuit under test
before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement instrument.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product.
Consult the product manual for further ratings information before making connections to the product.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it
inspected by qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.
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General Safety Summary

Terms in this Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product
or other property.
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Introduction to the Application Welcome

Welcome
DDR (Dual Data Rate) is a dominant and a fast growing memory technology. It offers the high data
transfer rates needed for virtually all computing applications, from consumer products to the most powerful
servers. The high speeds of these signals require high performance measurement tools.

The DDRA application includes compliance measurements as part of our DDR Analysis solution. The
DDR Analysis solution enables you to achieve new levels of productivity, efficiency, and measurement
reliability. It requires the Jitter and Eye Diagram Analysis tool (Opt. DJA) and the Advanced Search and
Mark capability (Opt. ASM).

Some of the DDRA features are:

Provides debug, analysis, and compliance into one solution for multiple DDR standards such as DDR
(see page 1), DDR2 (see page 1), DDR3 (see page 2), LPDDR (see page 2) and GDDR3 (see page 2)

Enables analysis of compliance measurements either through the DDRA or DPOJET application for
all bursts in an acquisition

Differentiates data reads from writes, or analyzes signal integrity on the clock or on a data (DQ) line
during Read or Write cycles, or measures Data to Strobe setup and hold during Write cycles

Includes limit files to test measurement pass/fail status per standard, speed grades and speed bins.
Supports non-standard speed grades

Provides both single-ended and differential measurements on Data, Strobe, Clock, Address and
Command signals

Includes comprehensive measurement statistics

Includes sophisticated graphical analysis tools such as Histograms, Time Trends, Spectrums, Bathtub
Plots, and Real-Time Eye® diagrams with superimposition of the strobe eye with the data eye

Produces consolidated HTML reports automatically with pass/fail information, statistical measurement
results, setup information and plots

Automatically applies signal slew rate derating of measurement limits for Address/Command and
data signals

Dynamically normalizes limits for clock measurements such as tERR based on the measured tCK(avg)

DDR
DDR is the DRAM (Dynamic Random Access Memory) technology responsible for increasing data
transfer rates to meet high-speed requirements and data capacity of computer systems.

DDR2
DDR2 is the Double Data Rate 2 SDRAM and is widely available in products with data rates up to
1066MT/s.

DDR Analysis 1



Introduction to the Application Related Documentation

DDR3
DDR3 DRAM memory is widely available in products and extends data rates to 1600 MT/s and
faster rates to come.

Low Power DDR
LPDDR (Low Power DDR) is an emerging technology for mobile phones and portable computing
devices, driven by the need for faster operation with long battery life.

Graphic DDR3
GDDR3 (Graphic DDR) offers faster access and is used in graphics-intensive applications such
as video cards and gaming systems.

Related Documentation
Tektronix manuals are available at: www.tektronix.com/manuals and www.tektronix.com/software. Use
the following table to determine the document that you need:

Table 1: List of reference documents
For information on Refer to

Operating the Oscilloscope Oscilloscope user manual.
Oscilloscope user online help.

Software warranty

List of available applications

Compatible oscilloscopes

Relevant software and firmware version numbers

Applying a new option key label

Installing an application

Enabling an application

Downloading updates from the Tektronix Web site

Optional Applications Software on Windows-Based
Oscilloscopes Installation Manual, which is provided on
the Optional Applications Software on Windows-Based
Oscilloscopes DVD, in the Documents directory.

xxx
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Introduction to the Application Conventions

Conventions
Online Help uses the following conventions:

When steps require a sequence of selections using the application interface, the “>” delimiter marks
each transition between a menu and an option. For example, Analyze > DDR Analysis.

The terms “DDR application” and “application” refer to DDRA.

The term “DPOJET application or “DPOJET” refers to Jitter and Eye Diagram Analysis Tool.

The term “oscilloscope” refers to any product on which this application runs.

The term “DUT” is an abbreviation for Device Under Test.

The term “select” is a generic term that applies to the methods of choosing an option: with a mouse or
with the touch screen.

User interface screen graphics are taken from a DPO7000 series oscilloscope.

You can find a PDF (portable document format) file for this document in the Documents directory on the
Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet contains
information on installing the application from the DVD and on how to apply a new label. You can also find
the PDF and the Online Help at Start > Programs >TekApplications > DDRA.

Table 2: Icon descriptions
Icon Meaning

This icon identifies important information.

This icon identifies conditions or practices that could result
in loss of data.

This icon identifies additional information that will help you
use the application more efficiently.

xxx

Technical Support
Tektronix welcomes your comments about products and services. Contact Tektronix through mail,
telephone, or the Web site. Click Contacting Tektronix for more information. Tektronix also welcomes
your feedback. Click Customer feedback for suggestions for providing feedback to Tektronix.
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Introduction to the Application Customer Feedback

Customer Feedback
Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or other comments you may have regarding the application or oscilloscope.

Direct your feedback via e-mail to

techsupport@tektronix.com

Or FAX at (503) 627-5695, and include the following information:

General Information
Oscilloscope model number (for example: DPO7000 or DSA/DPO70000/B series) and hardware
options, if any.

Software version number.

Probes used.

Application-specific Information
Description of the problem such that technical support can duplicate the problem.

If possible, save the oscilloscope and application setup files as .set and associated .xml files.

If possible, save the waveform on which you are performing the measurement as a .wfm file.

Once you have gathered this information, you can contact technical support by phone or through e-mail.
In the subject field, please indicate “DDRA Problem” and attach the .set, .xml and .wfm files to your
e-mail. If there is any query related to the actual measurement results, then you can generate a .mht report
and send it. If you need to send very large files, technical support can assist you to transfer the files
via ftp (file transfer protocol).

The following items are important, but optional:

Your name

Your company

Your mailing address

Your phone number

Your FAX number

Enter your suggestion. Please be as specific as possible.

Please indicate if you would like to be contacted by Tektronix regarding your suggestion or comments.
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Getting Started Product Description

Product Description
DDR Analysis is a standard specific solution tool for Tektronix Performance Digital Oscilloscopes
(DPO7000 and DSA/DPO70000/B series). DDR Analysis requires Jitter and Eye Diagram Analysis Tool
(Opt.DJA) and the advanced Search and Mark capability (Opt. ASM).

The features of DDRA are:

Provides debug, analysis, and compliance in one solution for multiple DDR standards such as DDR
(see page 1), DDR2 (see page 1), DDR3 (see page 2), LPDDR (see page 2), and GDDR3 (see page 2)

Supports multiple standards such as DDR, DDR2, DDR3, LPDDR and GDDR3

Identifies Read and/or Write operations automatically

Custom data rates and input levels to tailor DDRA Read and/or Write burst identification

Provides both single-ended and differential measurements on Data, Strobe, Clock, Address and
Command signals

Analyze compliance measurements either through DDRA or Jitter and Eye Diagram Analysis Tool

Limit files to test measurement pass/fail status

Automatically applies signal slew rate derating of measurement limits for Address/Command and
data signals

Dynamically normalizes limits for clock measurements such as tERR based on the measured tCK(avg)

DDRA Prerequisites
To use the DDRA application, you need to have Opt. ASM (Advanced Search and Mark Tool) and
DPOJET Advanced (Opt. DJA) enabled.

Requirements and Restrictions
Microsoft .NET Framework version 3.0 or higher, and MATLAB Component Runtime 7.5 are required to
operate DDRA on your oscilloscope. These are included in the distribution and automatically installed
with DDRA, if not already present.

Supported Probes
The application supports the following probes:
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TAP2500

TAP1500

TCP0030

P6158

P6101B

P6246

P6247 (DPO7254 only)

P6248 (DPO7254 only)

P6249

P6150

P6158

P7240

P7260

P7330

P7340A

P7350

P7360A

P7380A

P7313A

P7513

P7500 Series TriMode

Installing the Application
Refer to the Optional Applications Software on Windows-Based Oscilloscopes Installation Manual for the
following information:

Software warranty.

List of available applications, compatible oscilloscopes, and relevant software and firmware version
numbers.

Applying a new option installation key label.

Installing an application.
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Enabling an application.

Downloading updates from the Tektronix Web site.

You can find a PDF (portable document format) file for this document in the Documents directory on the
Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet contains
information on how to install the application from the DVD and on how to apply a new option installation
key label.

About DDRA
Click Help > About DDRA to view application details such as the software released version number,
application name and copyright.
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Starting the Application
On the oscilloscope menu bar, click Analyze > DDR Analysis to open the application.

Menu Controls
Table 3: Application Menu Controls descriptions
Item Description
Tab Shortcut to a menu in the menu bar or a category of menu

options; most tabs are short cuts.
Area Visual frame with a set of related options.
Option button Button that defines a particular command or task.
Field Box that you can use to type in text, or to enter a value with

the Keypad or a Multipurpose knob.
Check Boxes Use to select configuration options or clear preferences.
Browse Displays a window where you can look through a list of

directories and files.
Command button Button that initiates an immediate action such as Run

command button in the control panel.

Virtual Keypad icon
Click to use on-screen keypad to enter alphanumeric values.

MP knob references (a or b) Identifiers that show which Multi Purpose Knob (MPK) may
be used as an alternate means to control a parameter;
turn the knob on the oscilloscope front panel to adjust the
corresponding parameter. Also, the value can be entered
directly on the MPK display component.

xxx

Virtual Keypad

Select the icon and use the virtual keypad to enter alphanumeric values, such as reference voltage
levels.
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Tips on the DDRA User Interface
Here are some tips to help you with the application user interface:

Use the Single button to obtain a set of measurements from a single new waveform acquisition.
Pushing the button again before processing has completed will interrupt the processing cycle.

Use the Run button to continuously acquire and accumulate measurements. If prior
measurements have been acquired and have not been cleared, the new measurement are added to the
existing set. Push the button again to interrupt the current acquisition.

Use the Recalc button to perform measurements on the waveform currently displayed on the
oscilloscope without performing a new acquisition. This is useful if you wish to modify a configuration
parameter and re-run the measurements on the current waveform.

Use the Clear button to clear all existing measurement results. Note that adding or deleting
a measurement, or changing a configuration parameter of an existing measurement, will also cause
measurements to be cleared. This is to prevent the accumulation of measurement statistics or sets of
statistics that are not coherent.

Application Directories
The installation directory for DDRA executables is C:\Program Files\TekApplications\DDRA

and the installation directory for user files is C:\TekApplications\DDRA. During installation, the
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application sets up a limits folder in the user directory. This folder contains limit files for various DDR
standards and speed grades.

File Name Extensions
Table 4: File name extensions
File Extension Description
.csv An ascii file containing Comma Separated Values. This

file format may be read by any ascii text editor (such as
Notepad) or may be imported into spreadsheets such as
Excel.

.xml An ascii file containing measurement setup information,
limits or other data in Extensible Markup Language.

.set A binary file containing oscilloscope setup information in
a proprietary format.

.mht An HTML archive file, compatible with common Windows
applications; contains the full report, including text and
graphics.

.wfm A binary file containing an oscilloscope waveform record in
a recallable, proprietary format.

xxx

Returning to the Application
When you access oscilloscope functions, the DDRA control windows may be replaced by the oscilloscope
control windows or by the oscilloscope graticule. You can access oscilloscope functions in the following
ways:

From the menu bar on the oscilloscope, choose Analyze > DDR Analysis.

Alternatively, you can switch between recently used control panels using the forward or backward
arrows on the right corner of the control panel.

Control Panel
The Control Panel appears on the right of the application window. Using this panel, you can start or stop the
sequence of processes for the application and the oscilloscope to acquire information from the waveform.
The controls are Clear, Recalc, Single, and Run. The following table describes each of these controls:
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Item Description
Clear Clears the current result display and resets any statistical

results and autoset ref levels. For any input sources that
have reference level autoset enabled, clears the current
ref levels so that they will be recalculated during the next
acquisition.

Recalc Runs the selected measurements on the currently displayed
waveform(s), without first performing a new acquisition.

Single Initiates a single new acquisition and runs the selected
measurements.

Run Initiates new acquisitions and runs the selected
measurements repeatedly until Stop is clicked. For any
non-live sources (Reference waveforms or Math waveforms
not dependent on a live channel), only a single processing
cycle will occur.

Show Plots Displays the plot summary window when clicked. This
button appears in the control panel only when one or more
plots have been defined.

Advanced Setup DPOJET Transitions to the Jitter and Eye Diagram Analysis
application when clicked, importing all currently defined
DDRA measurements. This button appears in the control
panel when you open the DDR analysis application. This
is useful if you wish to add additional measurements
not defined in DDRA, or wish to change measurement
configurations to intentionally deviate from those
recommended by DDRA.

xxx

Saving a Setup
The DDRA application state is automatically saved along with the oscilloscope state. To save the
oscilloscope settings and the application state, follow these steps:

1. Click File > Save As > Setup.

2. In the file browser, select the directory to save the setup file.

3. Select or enter a file name. The application appends *_DDRA.xml and *_DPOJET.xml to store the
DDR setup, and *.set to store the oscilloscope settings.

4. Click Save.
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NOTE. After the oscilloscope application is started, DDRA needs to be launched at least once before
any saved DDRA configuration can be recalled.

Recalling a Saved Setup
To recall a previously saved set of application and oscilloscope settings, do the following steps:

1. Click File > Recall...

2. Click Setup in the left column if it is not already selected.

3. Select the directory in the file browser from which you wish to recall the setup file.

4. Select a .set file and click Recall.

NOTE. Only .set files can be selected for recall; any corresponding *_DDRA.xml and *_DPOJET.xml
file in the same directory will be recalled as well, if DDRA has been launched at least once since the
oscilloscope application was started. If DDRA has not been launched at least once, the oscilloscope
settings will be recalled but the DDRA configuration will be ignored.

Recalling the Default Setup
To recall the default application and oscilloscope settings, click File > Recall Default Setup.

NOTE. Recalling default setup sets the DDRA application to DDR3 generation and data rate, None.

Limits
A limits file allows you to configure the limits used to determine Pass or Fail status for tests. Each limits
file includes a list of one or more measurements, and the ranges of acceptable values for any or all statistics
for each measurement that include combinations of all measurements and statistical characteristics, and an
appropriate range of values for each combination.

The application provides preconfigured limits files for many combinations of standards and speed grades.
You can create one by specifying limits for any of the result parameters such as Mean, Std Dev, Max, Min,
peak-to-peak, population, MaxPosDelta and MinPosDelta. For each of these result parameters, you can
specify the Upper Limit Equality (ULE), Lower Limit Equality (LLE), or Both. The measurement names
in the limits file must be entered as mentioned in About DDR Analysis.

To include Pass/Fail status in the result statistics, you can create a custom limits file in the following
format using an XML editor or any other editor. If the file is created in any other editor such as Notepad,
it should be saved in Unicode format.
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The following is a sample of the limit file for DDR2 generation, the data rate being 667 MHz

<?xml version="1.0" encoding="utf-16" ?>

<Main>

<Measurement>

<NAME>DDR Hold–Diff</NAME>

<STATS>

<STATS_NAME>Min</STATS_NAME>

<LIMIT>BOTH</LIMIT>

<ULE>175e-12</ULE>

<LLE>0</LLE>

</STATS>

</Measurement>

<Measurement>

<NAME>tDH-Diff(base)</NAME>

<STATS>

<STATS_NAME>Min</STATS_NAME>

<LIMIT>BOTH</LIMIT>

<ULE>175e-12</ULE>

<LLE>0</LLE>

</STATS>

</Measurement>

</Main>

You can find limit files for various data rates of different DDR standards and speed bins at
C:/TekApplications/DDRA/Limits.

Dynamic Limits
The application supports both static (predefined using limits file) and dynamic limits. Dynamic limits
are available only for DDRA clock measurements. They are calculated using the result of other
measurement(s).

The concept of dynamic limits is explained taking an example of a measurement, tCH(avg):

If the dynamic limits of a measurement depend on the result of other measurement(s) that has not
yet been calculated, the limit text field in the results panel shows “Derived...”. A tool tip displays the
message “This limit is calculated based on measurement tCK(avg)”.
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On clicking Run/Single, the results are shown in the following figure:

If there is an error in calculating dynamic limits, the limit text field displays “Error...” as shown. A
tool tip displays the message “This limit is calculated based on measurement tCK(avg)”.

References
Dynamic Limits for LPDDR Measurements

Dynamic Limits for DDR Measurements

Dynamic Limits for DDR2 Measurements

Dynamic Limits for DDR3 Measurements
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DDR Standards and their Measurements
The following table lists the measurements displayed for each DDR standard:

NOTE. For more details on the measurements, refer to the Algorithms section.

Measurements DDR DDR2 DDR3 LP-DDR ‡ GDDR3 †

Write Bursts
Data Eye Width
Slew Rate-Hold-
Fall(DQ)
Slew Rate-Hold-
Rise(DQ)
Slew Rate-Hold-
SE-Fall(DQS)
Slew Rate-Hold-
SE-Rise(DQS)
Slew Rate-
Setup-Fall(DQ)
Slew Rate-
Setup-Rise(DQ)
Slew Rate-
Setup-SE-
Fall(DQS)
Slew Rate-
Setup-SE-
Rise(DQS)
tDH-Diff(base)
tDH-
Diff(derated)
tDH-SE(base)
tDH-
SE(derated)
tDQSH
tDQSL
tDS-SE(base)
tDS-
SE(derated)
tDS-Diff(base)
tDS-
Diff(derated)
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Measurements DDR DDR2 DDR3 LP-DDR ‡ GDDR3 †

tDIPW-SE
tDSS-Diff
tDSS-SE
tDQSS-Diff
tDQSS-SE
tDSH-Diff
tDSH-SE
Read Bursts
Data Eye Width
tDQSCK-Diff
tDQSCK-SE
tDQSQ-Diff
tDQSQ-SE
tAC-Diff
tQH
Slew Rate(Diff)
Input Slew-Diff-
Fall(DQS)
Input Slew-Diff-
Rise(DQS)
Input Slew-Diff-
Rise(CK)
Input Slew-Diff-
Fall(CK)
SRQdiff-
Rise(DQS)
SRQdiff-
Fall(DQS)
SRQdiff-
Rise(CK)
SRQdiff-
Fall(CK)
Clock(Diff)
tCH(abs)
tCH(avg)
tCK(abs)
tCK(avg)
tCL(abs)
tCL(avg)
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Measurements DDR DDR2 DDR3 LP-DDR ‡ GDDR3 †

tERR
(Includes
measurements
from tERR2 to
49per)
tERR(11–50per)
tERR(2per)
tERR(3per)
tERR(4per)
tERR(5per)
tERR(6–10per)
tJIT(cc)
tJIT(duty)
tJIT(per)
tHP
VID(ac)
Clock(Single Ended)
Vix(ac)CK
Vox(ac)CK
AC-Over-
shoot(CK)
AC-Over-
shoot(CK#)
AC-Under-
shoot(CK)
AC-Under-
shoot(CK#)
DQS(Single Ended)
Vix(ac)DQS
Vox(ac)DQS
AC-Over-
shoot(DQS)
AC-Over-
shoot(DQS#)
AC-Under-
shoot(DQS)
AC-Under-
shoot(DQS#)
Address/Command
tIS(base)
tIH(base)
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Measurements DDR DDR2 DDR3 LP-DDR ‡ GDDR3 †

tIS(derated)
tIH(derated)
tIPW-High
tIPW-Low
AC-Overshoot
AC-Undershoot
xxx

‡ The clock measurements displayed for LPDDR and DDR standards are tCH, tCK, tHP,, and tCL.
† The application displays a hint on selecting GDDR3 as the standard: “GDDR3 not completely supported. Some features may not function”.

Derating
Signal slew rate derating is required to verify the setup and hold timing requirements on address/command
and data signals. The base setup and hold limits are defined using input signals that have a 1.0 V/ns slew
rate. To determine final pass/fail status, the limits must be adjusted based on the actual slew rates of the
target signals, according to derating tables appearing in the DDR2 and DDR3 specifications.

DDR2 derated measurements for data signals are as follows:

tDS-SE(derated)

tDH-SE(derated)

tDS-Diff(derated)

tDH-Diff(derated)

DDR3 derated measurements are as follows:

tDS-Diff(derated)

tDH-Diff(derated)

The DDR2/DDR3 Address/Command derated measurements are as follows:

tIH(derated)

tIS(derated)

The derated value (Δ) is calculated as per the JEDEC standard using either the DDR Method or Nominal
Method, depending on the user configuration.

Derating is explained taking an example of Setup(tIS) measurement. The same concept is applicable for
other derated measurements.

When the nominal method is set, Setup(tIS) nominal slew rate for a rising signal is defined as the slew rate
between the last crossing of VREF(dc) and the first crossing of VIH(ac)min. Setup (tIS) nominal slew rate for
a falling signal is defined as the slew rate between the last crossing of VREF(dc) and the first crossing of
VIL(ac)max.
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If the DDR Method is set, the application takes the maximum slope. This method is applicable if the actual
signal is earlier than the nominal slew rate line.

According to the specified reference levels, rise slew rate is always positive whereas fall slew rate is
negative. A single slew rate value is obtained by averaging the absolute values of rise and fall slew
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rate. Using this value and a similarly-derived slew rate for the clock signal, the total setup time (tIS) is
calculated by adding ΔtIS to the tIS(base)limit from the following table:

Table 5: Address/Command Setup and Hold Values
Units(ps) DDR3–800 DDR3–1066 DDR3–1333 DDR3–1600
tIS(base) 200 125 65 45
tIH(base) 275 200 140 120
xxx

ΔtIS is determined using the derating table (AC 175 (see page 35)), where the Y-axis represents
the Address/Command slew rate and the X-axis, the clock differential value. By indexing the
Address/Command value and Clock differential value, ΔtIS value is obtained from AC175 table.

The calculated slew rate is approximated to the derating table specified value (Example: 0.4 V/ns ≈
1.0V/ns). For values greater than 4.0 V/ns, the table returns the base limit value.

For example: For a Clock differential value= 1.0 V/ns, Address/Command Slew Rate =1.0 V/ns, and AC
175 Threshold selected in Step 5 (see page 33), the resulting derated values are:

tISderatedlimit= tIS(base)limit+ΔtIS.
tISderatedlimit= 200+ 40= 240

The result statistics of the both tIS(base) and tIS(derated) are the same as shown in the following figure. In
case of derating, the limit values get changed depending on the signal slew rate.

Reference
DDR3 Measurement Sources

DDR2 Measurement Sources

About DDR Analysis
The DDR Analysis window allows you to select various standards, set up and run a pre-configured
measurement either through the DDRA or the DPOJET application.
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Select Analyze > DDR Analysis to open the DDRA application.

The setup panel in the DDR Analysis application includes the following steps:

Generate Rate and Levels

Measurements

Sources

Burst Detection

Thresholds and Scalings

NOTE. You can use the Next/Prev buttons or click directly on the step numbers to traverse through the

steps in the DDR Analysis. The steps for which configuration is complete are denoted .

The setup panel displays hints to help you understand the configuration options wherever applicable.

You can run a set of measurement in either of the two ways:

Click Run to start the acquisition sequence using the selected settings and to view the results in the
DDRA window. This is the normal way to generate results.

Click to move to the DPOJET application, where you can add or modify
measurements before sequencing. For more details, refer to the DPOJET Online Help. You need to

click in the DPOJET application to return to the DDRA window. Alternatively, you can
reselect Analyze >DDR Analysis from the menu bar.

Step1: Generation, Rate and Levels
Select the DDR generation, data rate and the voltage levels (if required). There are different speed bins for
each standard data rate for specific DDR generations.
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1. Select the DDR Generation from the drop-down list.

2. Select the Data Rate from the drop-down list. On selecting Custom, an edit box allows you to enter the
value using the virtual keypad. Limit files are not defined for custom data rates for Pass/Fail status and
as a result the application displays a hint at the bottom of the screen “Please provide a limits file under
Jitter and Eye > Limits”. Note that selecting non-standard data rates in ASM (under Search > DDR
Read or DDR Write), changes the data rate to “None” in DDRA.

3. Set the voltage levels:

If you select JEDEC Defaults, the application uses the nominal voltage levels according to the
JEDEC specification.

If you select User Defined, enter the Vdd (see page 23) or Vref (see page 23) voltage values
using the virtual keypad.

Vdd
Is the supply voltage for each DDR standard. Vdd is based on DDR generation.

Vref
Is the reference voltage for each DDR standard. Vref is calculated using Vdd, which in turn is based
on DDR generation. In most cases, Vref=0.5Vdd.

The following table lists the minimum and maximum values of Vdd and Vref in the User Defined mode
for all DDR generations:

DDR
Generations Vdd Vref

Default Min Max Default Min Max
DDR ‡ 2.5 V 1.5 V 3.6 V 1.25 V 750 mV 1.8 V
DDR2 1.8 V 1.08 V 2.52 V 900 mV 540 mV 1.26 V
DDR3 1.5 V 900 mV 2.1 V 750 mV 450 mV 1.05 V
LPDDR 1.8 V 1.08 V 2.52 V 900 mV 540 mV 1.26 V
GDDR3 1.8 V 1.08 V 2.52 V 900 mV 540 mV 1.26 V
xxx

‡ DDR 400 MT/s has Vdd value set to 2.6 V.

NOTE. If you select Manual Threshold Settings in Step 5 and then subsequently choose user-defined
Vdd or Vref voltages in Step 1 , the following message is displayed “You have selected manual control
of measurement thresholds in Step 5. Please verify that they are appropriate for these settings”. This is
because the Vref voltage is normally used to determine the proper high, mid, and low thresholds. If these
thresholds are under manual control, there is no point in manually setting Vref.
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Vdd and Vref
The configured values of Vdd and Vref are used to calculate VIH(ac)min, VIH(dc)min, VIL(dc)max and
VIL(ac)max, which are applied on the input signal. These levels are further used for calculating Setup
and Hold measurements.

For DDR2, the relationship between Vdd and Vref is as shown in the following tables:

Table 6: Input DC logic Level
Symbol Parameter Min Max Units
VIH(dc) DC input logic high Vref+0.125 – V
VIL(dc) DC input logic low –0.3 Vref–0.125 V
xxx

Table 7: Input AC logic Level
Symbol Parameter DDR2–400, DDR2–533 DDR2–667,DDR2–800 Units

Min Max Min Max
VIH(ac) AC input logic

high
Vref+0.250 – Vref+0.200 – V

VIL(ac) AC input logic
low

– Vref–0.250 – Vref+0.200 V

xxx

NOTE. Similar reference voltage levels are defined for DDR3 standard.

Speed Bins
For each DDR standard, the DDRA application automatically applies limits appropriate for the standard
data rates without speed bins. Limit values are different for different speed bins. If you want to test
according to a speed bin, you must manually configure the limit values from within DPOJET by manually
overriding the limit file before running the measurements.

For more details, refer to the topic “Limits” of the DPOJET help.

The following table lists the speed bins available for which pre-configured limit files are provided:

DDR Generation Speed bins
DDR-400 400A, 400B and 400C
DDR2
DDR2-667 800C and 800D
DDR2-800 800C, 800D and 800E
DDR3
DDR3-800 800D and 800E
DDR3-1066 1066E, 1066F and 1066G
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DDR Generation Speed bins
DDR3-1333 1333F *, 1333G, 1333H and 1333J *

DDR3-1600 1600G †, 1600H, 1600J and 1600K †

xxx

* 1333F and 1333J are optional

† 1600G and 1600K are optional

NOTE. You can find limit files for various speed bins at C:\TekApplications\DDRA\Limits. You need
to manually select these limit files by clicking Analyze > Jitter and Eye Analysis > Preferences > Limits.

Step2: Measurements
Measurement availability depends on the selected DDR standard. Select theMeasurement Type (Read
Bursts, Write Bursts, Slew Rate(Diff), Clock(Diff), Clock(Single Ended), DQS(Single Ended), or
Address/Command) from the drop-down list. A message prompts you to select one or more measurement
before moving to the next step.

Tree Structure Flow
The measurement tree structure flow is as follows:

The tree structure displays only the measurements appropriate for the selected measurement type.
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For the DDR3 generation, the Clock(Diff) measurement type displays both parent and nested elements
(such as tERR) as shown:

Click to expand and show the elements within the parent element.

Click to collapse and hide the elements within the parent element.

Selecting the parent check box, selects all the children elements. Selecting all the children elements,
selects the parent element.
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Clearing the parent check box clears all the children elements.

When the children include both checked and unchecked elements, the parent element becomes
highlighted as shown:

NOTE. If you move to the next step without selecting any measurements, the application displays the
message “Please select measurements in Step2”.

Measurement Selection Based on Signal Type
The application adds the suffix SE (Single-ended) or Diff ( Differential) for relevant measurements
depending on the signal type.

If your signal type is differential, the measurements with suffix Diff should be selected and those with
SE should be deselected. The signal should be probed with a differential probe. If only one leg of
a differential signal is probed (using a single-ended probe), the automatically-configured reference
levels will not be correct. This can be resolved by using a Math waveform as the source, and
defining the Math so that the single-ended signal is centered around 0 V. This will not be a proper
JEDEC-compliant measurement but it will allow the measurements and/or eye diagram to function.

If your signal type is single-ended, the measurements with suffix SE should be selected and those with
Diff should be deselected. Some measurements on differential signals demand that the two legs of the
differential signal be separately probed with single-ended probes. These measurements are placed in
measurement types that segregate them from measurements made with a differential probe.

For example: For DDR3 800 MT/s, Write burst selection shows both SE and Diff measurements as shown
in the following figure. You need to select appropriate measurements based on the signal type to obtain
valid results. For measurements with suffix Diff, DQ is SE and DQS is Diff whereas for measurements
with suffix SE, both DQ and DQS are SE. Measurements such as Data Eye Width, tDQSH and tDQSL
can be used for both Diff and SE measurements.
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NOTE. The application displays a hint “Cannot select Diff and SE measurements at the same time” when
measurements with suffix SE and Diff are selected together under Write Bursts of DDR2/DDR3 generation.

Timing error (tERR) measurements
Timing error measurements for the DDR3 generation such as tERR(2per), tERR(3per) until
tERR(50per) are grouped together and included as a nested element (tERR) under the parent element,
Clock(Diff)measurements. Selecting tERR selects all the timing error measurements.

Reference
Hints

Step3: Sources
On the sources step, identify all measurement sources that are required for your set of selected
measurements. The sources are mutually exclusive. The application displays only the sources applicable
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for the selected measurement(s). A maximum of four sources are available at a time. Example: Selecting
all SE measurements shows four sources such as DQS#, DQS(Strobe), Clock, and Clock#.

NOTE. If the same channels are used for DQ/DQS/Clock sources (Example: DQ=Ch1, DQS=Ch1),
the application displays a hint “Cannot use the same waveform for different sources”. If Live and Ref
channels are used together (Example: Ch1 for DQS and Ref2 for DQ), the application displays a hint
“Cannot use Live and Ref waveforms together”.

1. For each required signal, select the appropriate source.

2. If you wish to filter the data bursts based on a chip select signal, select the Chip Select source (see
page 30) using the Chip Select drop down. Set numeric values for CAS Min/CAS Max (see page 30),
and CS Level (see page 30) using the virtual keypad. Select CS Active (see page 30) and CS Mode
(see page 30) as shown in the following figure. Chip Select source is available only for Read and
Write bursts measurements.

NOTE. If a Chip Select source is selected, CS-DQS(Strobe) is used for signal separation otherwise
DQS(Strobe)-DQ(Data) is used. You need to configure DQ source to enable Search and Mark.
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Chip Select Source
Chip select source is used as a logic input to select read or write bursts corresponding to the chip
select signal. When a chip-select signal source other than none is specified, reads or writes will only
be shown when the chip-select source is active.

CAS Min/CAS Max
These values determine the CAS (Column Address Strobe) range for the memory being tested and
specify the time-delay (in clock cycles) from the chip-select signal to the read or write bursts. The
configured CAS range allows the user to offset the region where the chip-select logic source is
measured for activity.

CS Level
CS Level specifies the logic-level above or below which the chip-select level is considered active and
is applicable when CS Mode is set to Manual.

CS Active
Selects whether the chip-select source logic is considered active high or active low.

CS Mode
CS Mode consists of two modes– Auto and Manual. CS Auto mode calculates the level automatically
for you (as half the peak-to-peak voltage), while manual mode allows you to specify a CS level. In
cases where an entire acquisition could occur with no transitions on the chip-select line, you need to
select manual mode to set the correct logic level.

Reference
Hints

LPDDR Measurement Sources

DDR Measurement Sources

DDR2 Measurement Sources

DDR3 Measurement Sources

Step4: Burst Detection
The burst detection panel controls how data bursts are identified within a waveform that includes tri-state
levels. For appropriately-probed signals with good signal fidelity, no adjustment to the default values
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should be required. For signals with poor fidelity or unusual properties, burst detection can be improved
by switching to Manual control and adjusting the detection levels.

NOTE. The High/Mid/Low levels used for burst detection have no relationship to the reference levels used
for measurement points. The measurement thresholds are defined in Step 5 (see page 33).

Set the burst detection levels to view the results in the Mark table. For more details on how to view results,
refer to the “Search - Results: Mark Table Control Window” in your oscilloscope online help.

NOTE. Burst Detection is based on the measurement type and is applicable only for Write Bursts, Read
Bursts, and DQS(Single Ended) measurement types.

1. Select the type of burst detection level for the search.

If you select Auto, the application calculates these levels for you . It is recommended unless you
find that manual levels are necessary for reliable detection.

If you select Manual, enter both the Strobe and Data reference levels for the signal (High, Mid,
and Low). As you adjust the detection levels, observe the search-and-mark sprites that appear
above the waveform. These sprites are dynamically updated as you adjust the levels, helping
you to identify levels that properly delimit the selected burst type. Click Advanced under Burst
Detect to set the Edge Detection Hysteresis value, and the Termination Logic Margin in the
Advanced Burst Detection window.
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2. Click Advanced to view the search results in the Results:Mark table.

NOTE. Use the forward and backward arrows at the right corner of the control panel to switch between
DDRA and Results:Mark table window.

Reference
Hints

Advanced Burst Detection
The following advanced burst detection settings need not be changed in most cases:
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Edge Detection Hysteresis: This control configures the internal edge finder’s hysteresis band which
is used to detect read or write bursts. In the event of noisy inputs, it can be increased to correct
marks which may be larger than appropriate.

Termination Logic Margin: This control can be increased to help in terminating marks on
back-to-back writes in cases where otherwise a continuous strobe would cause a write-mark to merge
two back-to-back writes.

Step5: Thresholds and Scaling
The left half of this panel controls selection of critical voltage thresholds used by the measurement
algorithms. The right half determines whether scaling is automatically adjusted each time you sequence.

Measurement Thresholds
Select either Auto or Manual as the Measurement Threshold type.
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If you select Auto, the application calculates these levels for you based on the DDR generation and
speed grade. It is recommended that you use this option.

If you select Manual, set the measurements levels by clicking the Setup button.

For more details, refer to the topic “Ref Levels” of the DPOJET help.

NOTE. For every measurement selected in DDRA, appropriate reference levels are set in the DPOJET
application. You can change these levels, if needed, from the DPOJET application.

Vertical Scaling
Selecting Auto performs autoset on the oscilloscope vertical settings only.

For more details, refer to the topic “Source Autoset” of the DPOJET help.

Horizontal Scaling
Selecting Auto performs autoset on the oscilloscope horizontal settings only.

For more details, refer to the topic “Source Autoset” of the DPOJET help.

NOTE. If both Vertical and Horizontal are checked, the application performs autoset on both vertical and
horizontal oscilloscope settings when Single/Run is selected.

Alternate Thresholds
Alternate Thresholds only apply to the DDR3 Address and Command measurement type. It allows you
to select derating values(Δ) from the derating tables– AC 175 (see page 35) and AC 150. The default
is AC 175.
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AC 175 . The AC 175 Threshold derating table is as follows:

Table 8: Derating Values for DDR3 800/1066/1333/1600 MT/s tIS/tIH
ΔtIS, ΔtIH derating in ps AC/DC based
AC 175 Threshold(VIH(ac))= VREF(dc)+175 mV, VIL(ac)=VREF(dc)–175 mV
CK , CK# Differential Slew Rate

4.0 V/ns 3.0 V/ns 2.0 V/ns 1.8 V/ns 1.6 V/ns 1.4 V/ns 1.2 V/ns 1.0 V/ns
ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH

2.0 88 50 88 50 88 50 96 58 104 66 112 74 120 84 128 100
1.5 59 34 59 34 59 34 67 42 75 50 83 58 91 68 99 84
1.0 0 0 0 0 0 0 8 8 16 16 24 24 32 34 40 50
0.9 –2 –4 –2 –4 –2 –4 6 4 14 12 22 20 30 30 38 46
0.8 –6 –10 –6 –10 –6 –10 2 –2 10 6 18 14 26 24 34 40
0.7 –11 –16 –11 –16 –11 –16 –3 –8 5 0 13 8 21 18 29 34
0.6 –17 –26 –17 –26 –17 –26 –9 –18 –1 –10 7 –2 15 8 23 24
0.5 –35 –40 –35 –40 –35 –40 –27 –32 –19 –24 –11 –16 –2 –6 5 10

CMD/ADDR
Slew
rate
(v/ns)

0.4 –62 –60 –62 –60 –62 –60 –54 –52 –46 –44 –38 –36 –30 –26 –22 –10
xxx

AC 150 . The AC 150 Threshold derating table is as follows:

Table 9: Derating Values for DDR3 800/1066/1333/1600 MT/s tIS/tIH
ΔtIS, ΔtIH derating in ps AC/DC based
AC 150 Threshold(VIH(ac))= VREF(dc)+150 mV, VIL(ac)=VREF(dc)–150 mV
CK , CK# Differential Slew Rate

4.0 V/ns 3.0 V/ns 2.0 V/ns 1.8 V/ns 1.6 V/ns 1.4 V/ns 1.2 V/ns 1.0 V/ns
ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH ΔtIS ΔtIH

2.0 75 50 75 50 75 50 83 58 91 66 99 74 107 84 115 100
1.5 50 34 50 34 50 34 58 42 66 50 74 58 82 68 90 84
1.0 0 0 0 0 0 0 8 8 16 16 24 24 32 34 40 50
0.9 0 –4 0 –4 0 –4 8 4 16 12 24 20 32 30 40 46
0.8 0 –10 0 –10 0 –10 8 –2 16 6 24 14 32 24 40 40
0.7 0 –16 0 –16 0 –16 8 –8 16 0 24 8 32 18 40 34
0.6 –1 –26 –1 –26 –1 –26 7 –18 15 –10 23 –2 31 8 39 24
0.5 –10 –40 –10 –40 –10 –40 –2 –32 6 –24 14 –16 22 –6 30 10

CMD/ADDR
Slew
rate
(v/ns)

0.4 –25 –60 –25 –60 –25 –60 –17 –52 –9 –44 –1 –36 7 –26 15 –10
xxx

Reference
Hints
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Measurement Levels
By definition, edges occur when a waveform crosses specified reference voltage levels. Reference voltage
levels must be set so that the application can identify state transitions on a waveform. By default, the
application automatically chooses reference voltage levels when necessary.

The DDRA application uses three basic reference levels: High, Mid and Low. In addition, a hysteresis
value defines a voltage band that prevents a noisy waveform from producing spurious edges. The reference
levels and hysteresis are independently set for each source waveform, and are specified separately for
rising versus falling transitions.

Item Description
Measurement Reference Levels Setup (one level per source)
Rise High Sets the high threshold level for the rising edge of the source.
Rise Mid Sets the middle threshold level for the rising edge of the source.
Rise Low Sets the low threshold level for the rising edge of the source.
Fall High Sets the high threshold level for the falling edge of the source.
Fall Mid Sets the middle threshold level for the falling edge of the source.
Fall Low Sets the low threshold level for the falling edge of the source.
Hysteresis Sets the threshold margin to the reference level which the voltage must cross to

be recognized as changing; the margin is the relative reference level plus or
minus half the hysteresis; use to filter out spurious events.

xxx
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Hints
The DDRA application displays the following hints at different steps:

Hint Step Description
Select a standard data rate in DDRA 1 Displayed when data rate is None. When you select a

non standard data rate in ASM, the data rate is set to
None in DDRA.

GDDR3 not completely supported.
Some features may not function.

1 Displayed on selecting GDDR3 standard, which does
not have standard data rates. Only Data Eye Width
measurement is available for both Read and Write bursts.

Please provide a Limits file under
Jitter and Eye > Limits

1 Displayed for custom data rates for which limits are not
defined. You need to manually configure the limits.

You have selected manual control of
measurement thresholds in Step 5.
Please verify that they are appropriate
for these settings.

1 Displayed when Vdd or Vref values are set to User
Defined in Step 1 after thresholds are set to Manual in
Step 5.

Cannot use Live and Ref waveforms
together.

2 or 3 Displayed on selecting both Live and Ref waveforms
as source for DQ and DQS. Example: Data Eye Width
measurement with sources as Ch1 for DQ and Ref1 for
DQS.

Cannot use the same waveform for
different sources.

2 or 3 Displayed on selecting the same source for DQ and DQS.
Example: Data Eye Width using Ch3 for both DQ and
DQS.

Cannot select Diff and SE
measurements at the same time.

2 Displayed on selecting measurements with suffix SE and
Diff. Example: DDR2, Write bursts, tDH-Diff and tDH-SE
measurements.

Use unique sources that are either
Live or Ref.

2 or 3 Displayed on selecting measurements which require DQ,
DQS and Clock sources. Example: DDR3, 800MT/s,
select all Read burst measurements.

xxx

Results as Statistics
Result statistics for most of the measurements show Population in terms of UI or transitions. According to
the JEDEC specification, the analysis for most of the clock measurements is done for a 200-cycle moving
window. However, for clock measurements such as tCL(avg) and tCH(avg), the population is shown as
tCK(avg) units. For some measurements such as Data Eye Width, exactly one measurement occurs per
acquisition. For such measurements, the population increases by one for each acquisition independent
of the number of UI in the acquisition.
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Reference
Dynamic Limits

For more details, refer to the topic “Viewing Statistical Results” of the DPOJET help.

Plots
The only measurement for which a plot is automatically configured is Data Eye Width, which is available
for both Read and Write bursts. However, plots may be added for other measurements through the plot
panel. The plot selection and configuration methods are identical to those used for DPOJET. For more
details, refer to the DPOJET help.

For acquisitions containing more than one read or write burst, time trend plots connect together all
measurements within each burst with a continuous line, but do not draw lines between bursts. If a vertical
cursor is placed where it does not intersect a line, the cursor annotation will read "NaN" (Not a Number).

For more details, refer to the topic “About Configuring Plots” of the DPOJET help.
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Reports

For more details, refer to the topic “About Reports” of the DPOJET help.

Switching between the DDRA and DPOJET Applications

For advanced analysis, click to switch to the DPOJET application. Likewise, click

in the DPOJET application to revert to the DDRA application.

The transition behaves as follows:

The application name in the title bar switches between DDR Analysis and Jitter and Eye Diagram
Analysis Tool.

Measurement name remains unchanged while traversing from DDRA to DPOJET.

Within DPOJET, more measurements may be added to those automatically configured in DDRA.
These measurements must be configured manually.

Once in DPOJET, measurements automatically configured by DDRA may be reconfigured. (The
measurements will generally no longer be JEDEC-compliant in this case.)

Upon returning to DDRA, new or non-standard measurements will be retained.

Measurement sequencing, results analysis and report generation can be done from either application.

Any change in generation and measurement type in the DDRA deselects all the currently selected
measurements.

Switching back from DPOJET to DDRA, always resets focus to the Setup panel.
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DPOJET or DDRA application is always accessible from the oscilloscope menu bar, as an alternative
to the quick navigation buttons.

If DPOJET application is opened from the oscilloscope menu (Analyze > Jitter and Eye Diagram
Analysis), the shortcut button to DDR Analysis is not shown. This shortcut only appears if DPOJET
is entered from the DDRA interface.
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Introduction to the Tutorial
This tutorial teaches how to set up the application, take measurements, and view results as plots or statistics.

Before you begin the tutorial, perform the following tasks:

Set up the oscilloscope.

Start the application.

Recall the tutorial waveform.

Setting Up the Oscilloscope
The steps to set up the oscilloscope are:

Click File > Recall Default Setup in the oscilloscope menu bar to recall the default settings.

Press the individual CH1, CH2, CH3, and CH4 buttons as needed to add or remove active waveforms
from the display.

Starting the Application
Click Analyze > DDR Analysis to open the application.

Waveform Files
The DDRA application provides the following waveforms at C:\TekApplications\DDRA\Waveforms:

DDR2_800_DQS_Write.wfm

DDR2_800_DQ_Write.wfm

DDR2_800_CLK.wfm

NOTE. These waveforms have to be used only for Write bursts and CLK.

Recalling a Waveform File
To recall a waveform file, follow these steps:
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1. Click File > Recall in the oscilloscope menu bar to display the Recall dialog box.

2. Click Waveform icon in the left of the Recall dialog box.

3. Select Ref1, Ref2, Ref3, or Ref4 as the Destination option.

4. Browse to select the waveform. Use the keypad to edit the waveform file name.

5. Click Recall. The oscilloscope recalls and activates the Reference Waveform control window.

6. Click On to display the waveform.

7. Click to return to the application. Alternatively, DDRA can also be accessed from Analyze >
DDR Analysis.

Taking a Measurement
In this tutorial, we are taking the following example:

DDR2 800MT/s, Write bursts - Differential measurements

Waveforms Used: DDR2_800_DQS_Write.wfm and DDR2_800_DQ_Write.wfm

1. To set the application to default values, click File > Recall Default Setup. This is not necessary if
you have just started the application.

2. To view the DDRA application, select Analyze > DDR Analysis.

3. At Step 1, select the DDR2 standard and the data rate as 800 MT/s. The default voltage settings
are retained as shown:

4. At Step 2, select all the measurements except tDS-SE(base) and tDH-SE(base) under Write bursts as
shown. This is because the reference waveform is differentially probed.
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5. At Step 3, select the sources. In this example, DQS is recalled as Ref1 and DQ as Ref2 as shown.
Since none of the selected measurements requires the clock, the clock source selection will be ignored.

NOTE. Alternatively, you could simply click Single from step 3 since no more configuration changes
will be made.

6. At Step 4, retain the default settings as shown:

7. At Step 5, retain the default settings as shown:
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8. Click Single to run the application. When complete, the result statistics with limits are shown in the
results tab.

The eye diagram plot is displayed as shown:
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About Parameters
This section describes the DDRA application parameters and includes the menu default settings. Refer to
the user manual of your oscilloscope for operating details of other controls, such as front-panel buttons.

The parameter tables list the selections or range of values available for each option, the incremental unit of
numeric values, and the default selection or value.

Step1: Generation, Rate and Levels Parameters
Step1 includes the following parameters:

Table 10: Generation, Rate and Levels Parameters
Option Parameters Default setting
DDR Generation DDR, DDR2, DDR3, LPDDR and

GDDR3
DDR3

Data Rate † DDR: 200 MT/s, 266 MT/s, 333 MT/s,
400 MT/s, Custom and None
DDR2: 400 MT/s, 533 MT/s, 667
MT/s, 800 MT/s, 1066 MT/s, Custom
and None
DDR3: 800 MT/s, 1066 MT/s, 1333
MT/s, 1066 MT/s, Custom and None
LPDDR: 200 MT/s, 266 MT/s, Custom
and None
GDDR3: 500 MT/s, 600 MT/s, 700
MT/s, 800 MT/s, 900 MT/s, 1000
MT/s, 1200 MT/s, Custom and None

200 MT/s for LPDDR and DDR
400 MT/s for DDR2
None for DDR3
500 MT/s for GDDR3

Vdd JEDEC Default, User Defined JEDEC Default
Vref JEDEC Default, User Defined JEDEC Default
xxx

† Data rate varies for different DDR standards.

Step2: Measurements Parameters
Step2 includes the following parameters under Measurement Type:

Read Bursts

Write Bursts

Slew Rate(Diff)

Clock(Diff)
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Clock(Single Ended)

DQS(Single Ended)

Address/Command

Step3: Sources Parameters
Step3 includes the following parameters:

Table 11: Source Parameters
Option Parameters Default setting
DQS(Strobe) Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch1
DQS#(Strobe) Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch3
DQ(Data) Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch2
Addr/Cmd Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch4
Clock Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch3
Clock# Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch4
Chip Select None, Ch1-Ch4, Ref1-Ref4,

Math1-Math4
None

CS Mode * Auto, Manual Auto
CAS Min * 0–1k 2.0
CS Active * High, Low Low
CS Level * Left, Right 0.0
CAS Max * 0–1k 3.0
xxx

* Available only when Chip select source is selected.

Step4: Burst Detection Parameters
Step4 has the following parameters:

Table 12: Burst Detection Parameters
Option Parameters Default setting
Detection Levels Auto, Manual Auto
Advanced Burst Detection †

Edge Hysteresis 0–50% 10%
Termination Logic Margin 0–100% 0%
xxx

† Available only for Manual Burst detection.
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Step5: Thresholds and Scaling Parameters
Step5 has the following parameters:

Table 13: Thresholds and Scaling Parameters
Option Parameters Default setting
Thresholds Auto, Manual Auto
Vertical Scaling Set, Clear Clear
Horizontal Scaling Set, Clear Clear
Alternate Thresholds * AC 175, AC 150 AC175
Measurement Levels
Rise High –20 V to 20 V 1 V
Rise Mid –20 V to 20 V 0 V
Rise Low –20 V to 20 V –1 V
Fall High –20 V to 20 V 1 V
Fall Mid –20 V to 20 V 0 V
Fall Low –20 V to 20 V –1 V
Hysteresis 0 to 10 V 30 mV
xxx

* Available only for Address and Command Measurement type.
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LPDDR Measurement Sources
The sources required for analysis are DQS (Strobe), DQS# (Strobe), DQ (Data) , Clock, Clock #, and
Addr/Cmd. DQ and DQS can be either Single-Ended (SE) or Differential (Diff). Read and Write bursts
have CS as an optional source.

The following table lists the sources required for each LPDDR measurement:

DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

Write Bursts
Data Eye Width Eye Width DQS and DQ None
tDH-SE DDR Hold-SE DQ and DQS-Diff None
tDIPW-SE High Time DQ DQS †

tDQSH Pos Width DQS-Diff and DQ-SE None
tDQSL Neg Width DQS-Diff and DQ None
tDQSS-Diff Skew DQS-Diff and Clock DQ †

tDQSS-SE Skew DQS-Diff and Clock DQ †

tDSH-Diff Hold DQS-Diff and Clock DQ †

tDSH-SE Hold DQS-Diff and Clock DQ †

tDSS-Diff Setup DQS-Diff and Clock DQ †

tDSS-SE Setup DQS-Diff and Clock DQ †

tDS-SE Setup DQS-SE and DQ None
Read Bursts
Data Eye Width Eye Width DQS and DQ None
tAC-Diff DDR Setup-Diff DQ and Clock DQS †

tDQSCK-Diff Skew DQS and Clock DQ †

tDQSQ-SE Setup DQS-SE and DQ None
tQH Hold DQS-Diff and DQ None
Clock(Diff)
tCH Pos Width Clock None
tCK Period Clock None
tCL Neg Width Clock None
tHP Period Clock None
VID(ac) High–Low Clock None
Clock(Single Ended)
AC-Overshoot(CK#) Overshoot Clock# None
AC-Overshoot(CK) Overshoot Clock None
AC-Undershoot(CK#) Undershoot Clock# None
AC-Undershoot(CK) Undershoot Clock None
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DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

Vix(ac)CK V-Diff-Xovr Clock and Clock# None
DQS(Single Ended)
AC-Overshoot(DQS#) Overshoot DQS#, DQ and DQS-SE None
AC-Overshoot(DQS) Overshoot DQS-SE and DQ None
AC-Undershoot(DQS#) Undershoot DQS#, DQ and DQS-SE None
AC-Undershoot(DQS) Undershoot DQS-SE and DQ None
Vix(ac)DQS V-Diff-Xovr DQS#, DQ and DQS-SE None
Address/Command
AC-Overshoot Overshoot Addr/Cmd None
AC-Undershoot Undershoot Addr/Cmd None
tIH(base) DDR Hold–SE Clock and Addr/Cmd None
tIPW-High High Time Addr/Cmd None
tIPW-Low Low Time Addr/Cmd None
tIS(base) DDR Setup–SE Clock and Addr/Cmd None
xxx

† Required so that the Search-and-Mark feature can properly identify bursts

DDR Measurement Sources
The sources required for analysis are DQS(Strobe), DQ(Data), DQS# (Strobe), Clock, Clock#, and
Addr/Cmd. DQ and DQS can be either Single-Ended (SE) or Differential (Diff). Chip Select is available,
as appropriate, as an optional qualifier.

The following table lists the sources required for each DDR measurement:

DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

Write Bursts
Data Eye Width Eye Width DQS and DQ None
tDH-SE DDR Hold-SE DQS-SE and DQ None
tDIPW-SE High Time DQ DQS *

tDQSS-Diff Skew DQS-Diff and Clock DQ *

tDQSS-SE Skew DQS-Diff and Clock DQ *

tDSH-Diff Hold DQS-Diff and Clock DQ *

tDSH-SE Hold DQS-Diff and Clock DQ *

tDSS-Diff Setup DQS-Diff and Clock DQ *

tDSS-SE Setup DQS-Diff and Clock DQ *

tDS-SE Setup DQS-SE and DQ None
Read Bursts
Data Eye Width Eye Width DQS and DQ None
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DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

tAC-Diff DDR Setup-Diff DQ and Clock DQS *

tDQSCK-Diff Skew DQS and Clock DQ *

tDQSQ-SE Setup DQS-SE and DQ None
tQH Hold DQS-Diff and DQ None
Clock(Diff)
tCH Pos Width Clock None
tCK Period Clock None
tCL Neg Width Clock None
tHP Period Clock None
VID(ac) High–Low Clock None
Clock(Single Ended)
AC-Overshoot(CK#) Overshoot Clock# None
AC-Overshoot(CK) Overshoot Clock None
AC-Undershoot(CK#) Undershoot Clock# None
AC-Undershoot(CK) Undershoot Clock None
Vix(ac)CK V–Diff–Xovr Clock and Clock# None
DQS(Single Ended)
AC-Overshoot(DQS#) Overshoot DQS#, DQS-SE and DQ None
AC-Overshoot(DQS) Overshoot DQS-SE and DQ None
AC-Undershoot(DQS#) Undershoot DQS#, DQS-SE and DQ None
AC-Undershoot(DQS) Undershoot DQS-SE and DQ None
Vix(ac)DQS V–Diff–Xovr DQS-SE and DQS# None
Address/Command Measurements
AC-Overshoot Overshoot Addr/Cmd None
AC-Undershoot Undershoot Addr/Cmd None
tIH(base) DDR Hold–SE Clock and Addr/Cmd None
tIPW-High High Time Addr/Cmd None
tIPW-Low Low Time Addr/Cmd None
tIS(base) DDR Setup–SE Clock and Addr/Cmd None
xxx

* Required so that the Search-and-Mark feature can properly identify bursts
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DDR2 Measurement Sources
The sources required for analysis are DQS(Strobe), DQ(Data), DQS# (Strobe), Clock, Clock#, Chip
Select, and Addr/Cmd. DQ and DQS can be either Single-Ended (SE) or Differential (Diff). Read and
Write bursts have CS as an optional source.

The following table lists the sources required for each DDR2 measurement:

DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

Write Bursts
Data Eye Width Eye Width DQS and DQ None
Slew Rate-Setup-Rise(DQ) Rise Slew Rate DQ DQS †

Slew Rate-Setup-SE-
Rise(DQS)

Rise Slew Rate DQS-SE DQ †

Slew Rate-Setup-Fall(DQ) Fall Slew Rate DQ DQS †

Slew Rate-Setup-SE-
Fall(DQS)

Fall Slew Rate DQS-SE DQ †

Slew Rate-Hold-Rise(DQ) Rise Slew Rate DQ DQS †

Slew Rate-Hold-SE-
Rise(DQS)

Rise Slew Rate DQS-SE DQ †

Slew Rate-Hold-Fall(DQ) Fall Slew Rate DQ DQS †

Slew Rate-Hold-SE-
Fall(DQS)

Fall Slew Rate DQS-SE DQ †

tDH-Diff(base) DDR Hold–Diff DQS-Diff and DQ None
tDH-Diff(derated) DDR Hold–Diff DQS-Diff and DQ None
tDH-SE(base) DDR Hold–SE DQS-SE and DQS# None
tDH-SE(derated) DDR Hold–SE DQS-SE and DQS# None
tDIPW-SE High Time DQ DQS †

tDQSH Pos Width DQS-Diff and DQ None
tDQSL Neg Width DQS-Diff and DQ None
tDQSS-Diff Skew DQS-Diff and Clock DQ †

tDQSS-SE Skew DQS-Diff and Clock DQ †

tDSH-Diff Hold DQS-Diff and Clock DQ †

tDSH-SE Hold DQS-Diff and Clock DQ †

tDSS-Diff Setup DQS-Diff and Clock DQ †

tDSS-SE Setup DQS-Diff and Clock DQ †

tDS-Diff(base) Setup DQS-Diff and DQ None
tDS-Diff(derated) Setup DQS-Diff and DQ None
Read Bursts
Data Eye Width Eye Width DQS and DQ None
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DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

tAC-Diff DDR Setup-Diff DQ and Clock DQS †

tDQSCK-Diff Skew DQS and Clock DQ †

tDQSCK-SE Skew DQS and Clock None
tDQSQ-Diff DDR Setup-Diff DQS and DQ None
tDQSQ-SE Setup DQ and DQS-SE None
tQH Hold DQS-Diff and DQ None
Slew Rate(Diff)
InputSlew-Diff-Fall(CK) Fall Slew Rate Clock None
InputSlew-Diff-Fall(DQS) Rise Slew Rate DQS-Diff None
InputSlew-Diff-Rise(CK) Rise Slew Rate Clock None
InputSlew-Diff-Rise(DQS) Fall Slew Rate DQS-Diff None
Clock(Diff)
tCH(abs) Pos Width Clock None
tCH(avg) DDR tCH(avg) Clock None
tCK(abs) Period Clock None
tCK(avg) DDR tCK(avg) Clock None
tCL(abs) Neg Width Clock None
tCL(avg) DDR tCL(avg) Clock None
tERR(11–50per) DDR tERR(m–n) Clock None
tERR(2per) DDR tERR(n) Clock None
tERR(3per) DDR tERR(n) Clock None
tERR(4per) DDR tERR(n) Clock None
tERR(5per) DDR tERR(n) Clock None
tERR(6–10per) DDR tERR(m–n) Clock None
tHP Period Clock None
tJIT(cc) CC–Period Clock None
tJIT(duty) DDR tJIT(duty) Clock None
tJIT(per) DDR tJIT(per) Clock None
VID(ac) High–Low Clock None
Clock(Single Ended)
AC-Overshoot(CK#) Overshoot Clock# None
AC-Overshoot(CK) Overshoot Clock None
AC-Undershoot(CK#) Undershoot Clock# None
AC-Undershoot(CK) Undershoot Clock None
Vix(ac)CK V–Diff–Xovr Clock and Clock# None
Vox(ac)CK V–Diff–Xovr Clock and Clock# None
DQS(Single Ended)
AC-Overshoot(DQS#) Overshoot DQS#, DQS-SE and DQ None
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DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

AC-Overshoot(DQS) Overshoot DQ and DQS-SE None
AC-Undershoot(DQS#) Undershoot DQS#, DQS-SEand DQ None
AC-Undershoot(DQS) Undershoot DQS-SE and DQ None
Vix(ac)DQS V–Diff–Xovr DQS-SE and DQS# None
Vox(ac)DQS V–Diff–Xovr DQS-SE and DQS# None
Address/Command Measurements
AC-Overshoot Overshoot Addr/Cmd None
AC-Undershoot Undershoot Addr/Cmd None
tIH(base) DDR Hold–SE Clock and Addr/Cmd None
tIH(derated) DDR Hold–SE Clock and Addr/Cmd None
tIPW-High High Time Clock and Addr/Cmd None
tIPW-Low Low Time Clock and Addr/Cmd None
tIS(base) DDR Setup–SE Clock and Addr/Cmd None
tIS(derated) DDR Setup–SE Clock and Addr/Cmd None
xxx

† Required so that the Search-and-Mark feature can properly identify bursts

DDR3 Measurement Sources
The sources required for analysis are DQS(Strobe), DQ(Data), DQS# (Strobe), Clock, Clock#, and
Addr/Cmd. DQ and DQS can be either Single-Ended (SE) or Differential (Diff). Chip Select is available,
as appropriate, as an optional qualifier.

The following table lists the sources required for each DDR3 measurement:

DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

Write Bursts
Data Eye Width Eye Width DQS and DQ None
Slew Rate-Setup-Rise(DQ) Rise Slew Rate DQ DQS ‡

Slew Rate-Setup-Fall(DQ) Fall Slew Rate DQ DQS ‡

Slew Rate-Hold-Rise(DQ) Rise Slew Rate DQ DQS ‡

Slew Rate-Hold-Fall(DQ) Fall Slew Rate DQ DQS ‡

tDH-Diff(base) DDR Hold-Diff DQS-Diff and DQ-SE None
tDH-Diff(derated) DDR Hold-Diff DQ and DQS-Diff None
tDIPW-SE High Time DQ DQS
tDQSH Pos Width DQS-Diff and DQ None
tDQSL Neg Width DQS-Diff and DQ None
tDQSS-Diff Skew DQS-Diff and Clock DQ ‡

tDQSS-SE Skew DQS-Diff and Clock DQ ‡
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DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

tDSH-Diff Hold DQS-Diff and Clock DQ ‡

tDSH-SE Hold DQS-Diff and Clock DQ ‡

tDSS-Diff Setup DQS-Diff and Clock DQ ‡

tDSS-SE Setup DQS-Diff and Clock DQ ‡

tDS-Diff(base) DDR Setup–Diff DQS-Diff and DQ None
tDS-Diff(derated) DDR Setup–Diff DQ and DQS-Diff None
Read Bursts
Data Eye Width Eye Width DQS and DQ None
tDQSCK-Diff Skew DQS and Clock DQ ‡

tDQSQ-Diff Setup DQS and DQ None
tQH Hold DQ and DQS-Diff None
Slew Rate(Diff)
SRQdiff-Fall(CK) Fall Slew Rate Clock None
SRQdiff-Fall(DQS) Fall Slew Rate DQS-Diff DQ ‡

SRQdiff-Rise(CK) Rise Slew Rate Clock None
SRQdiff-Rise(DQS) Rise Slew Rate DQS-Diff DQ
Clock(Diff)
tCH(abs) Pos Width Clock None
tCH(avg) DDR tCH(avg) Clock None
tCK(abs) Period Clock None
tCK(avg) DDR tCK(avg) Clock None
tCL(abs) Neg Width Clock None
tCL(avg) DDR tCL(avg) Clock None
tERR DDR tERR Clock None
tJIT(cc) CC–Period Clock None
tJIT(duty) DDR tJIT(duty) Clock None
tJIT(per) DDR tJIT(per) Clock None
Clock(Single Ended)
AC-Overshoot(CK#) Overshoot Clock# None
AC-Overshoot(CK) Overshoot Clock None
AC-Undershoot(CK#) Undershoot Clock# None
AC-Undershoot(CK) Undershoot Clock None
DQS(Single Ended)
AC-Overshoot(DQS#) Overshoot DQ, DQS-SE, Clock and

DQS#
None

AC-Overshoot(DQS) Overshoot DQS-SE and DQ None
AC-Undershoot(DQS#) Undershoot DQS#, DQ and DQS-SE None
AC-Undershoot(DQS) Undershoot DQS-SE and DQ None
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DDR measurements
DPOJET base
measurement Performed on

Additional required
sources

Address/Command Measurements
AC-Overshoot Overshoot Addr/Cmd None
AC-Undershoot Undershoot Addr/Cmd None
tIH(base) DDR Hold–SE Clock and Addr/Cmd None
tIH(derated) DDR Hold–SE Clock and Addr/Cmd None
tIPW-High High Time Addr/Cmd None
tIPW-Low Low Time Addr/Cmd None
tIS(base) DDR Setup–SE Clock and Addr/Cmd None
tIS(derated) DDR Setup–SE Clock and Addr/Cmd None
xxx

‡ Required so that the Search-and-Mark feature can properly identify bursts

Measurement Range Limits
The following tables lists the measurement range limits of DDR measurements for different standards
and data rate:

NOTE. Measurement Range Limits are provided for each measurement under the General configure
tab of the DPOJET application. These range limits are always ON (OFF is disabled) for two source
measurements such as Skew, Setup, Hold and others. The range limits are used by the algorithms to
associate valid edge of first source to the valid edge of the second source.

Generation Data rate
UI=1/CK
speed Measurement range

Read bursts Write bursts
Max=+ UI/2 Min=-UI/2 Max= UI Min=0

LPDDR 200 MT/s 5 ns 2.5 ns – 2.5 ns 5 ns 0
266 MT/s 3.759 ns 1.880 ns –1.880 ns 3.760 ns 0

DDR 200 MT/s 5 ns 2.5 ns – 2.5 ns 5 ns 0
266 MT/s 3.759 ns 1.880 ns –1.880 ns 3.76 ns 0
333 MT/s 3.003 ns 1.5 ns –1.5 ns 3 ns 0
400 MT/s 2.5 ns 1.25 ns –1.25 ns 2.5 ns 0

DDR2 400 MT/s 2.5 ns 1.25 ns –1.25 ns 2.5 ns 0
533 MT/s 1.876 ns 0.938 ns –0.938 ns 1.88 ns 0
667 MT/s 1.5 ns 0.7496 ns –0.7496 ns 1.5 ns 0
800 MT/s 1.25 ns 0.625 ns –0.625 ns 1.25 ns 0
1066 MT/s 0.938 ns 0.469 ns –-0.469ns 0.938 ns 0

DDR3 800 MT/s 1.25 ns 0.625 ns –0.625 ns 1.25 ns 0
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Generation Data rate
UI=1/CK
speed Measurement range

1066 MT/s 0.938 ns 0.469 ns –-0.469 ns 0.938 ns 0
1333 MT/s 0.75 ns 0.375 ns –0.375 ns 0.75 ns 0
1600 MT/s 0.625 ns 0.3125 ns –0.3125 ns 0.625 ns 0

xxx

The following measurements have different range limits as shown:

Measurement range Read bursts Write bursts Addr/Cmd
tDS-SE(base)
tDS-SE(derated)
tDS-Diff(base)
tDS-Diff(derated)
tDH-SE(base)
tDH-SE(derated)
tDH-Diff(base)

0 to 1 UI

tDH-Diff(derated)
tDSH-Diff tIH(base)
tDSH-SE tIH(derated)
tDSS-Diff tIS(base)

0 to 2UI

tDSS-SE tIS(derated))
0.5 to 1.5 UI tQH

tDQSCK-Diff tDQSS-Diff–1UI to +1UI
tDQSCK-SE tDQSS-SE

xxx

Dynamic Limits for LPDDR Measurements
The following table lists the dynamic limits for LPDDR measurements, which are common for all
LPPDR data rates. For more details, refer to the LPDDR JEDEC standard specification mentioned in the
application readme.txt.

NOTE. Dynamic limits are the same for all LPDDR data rates.

Table 14: Dynamic Limits for LPDDR
Dynamic limits

Measurement Min Max Units
tCH 0.45 0.55 tCK
tCL 0.45 0.55 tCK
Vix(ac)CK 0.4 * Vdd 0.6 * Vdd –
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Table 14: Dynamic Limits for LPDDR (cont.)

Dynamic limits
Measurement Min Max Units
Vix(ac)DQS 0.4 * Vdd 0.6 * Vdd –
Vid(ac) 0.6 * Vdd *Vdd+0.6 –

xxx

Dynamic Limits for DDR Measurements
The following table lists the dynamic limits for DDR measurements, which are common for all DDR data
rates. For more details, refer to the DDR JEDEC standard specification mentioned in the application
readme.txt.

NOTE. Dynamic limits are the same for all DDR data rates.

Table 15: Dynamic Limits for DDR
Dynamic limits

Measurement Min Max Units
tCH 0.45 0.55 tCK
tCL 0.45 0.55 tCK
Vix(ac)CK 0.5*Vdd–0.2 0.5*Vdd+0.2 –
Vix(ac)DQS 0.5*Vdd–0.2 0.5*Vdd+0.2 –
Vid(ac) 0.7 Vdd+0.6 –

xxx

Dynamic Limits for DDR2 Measurements
The following table lists the dynamic limits for DDR2 measurements. For more details, refer to the DDR2
JEDEC standard specification mentioned in the application readme.txt.

NOTE. Dynamic limits are the same for all DDR2 data rates except for those data rates specifically
mentioned in the table.

Table 16: Dynamic Limits for DDR2
Dynamic limits

Measurement Data rate (MT/s) Min Max Units
tCH(avg) 667, 800 0.48 0.52 tCK(avg)
tCL(avg) 667, 800 0.48 0.52 tCK(avg)
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Table 16: Dynamic Limits for DDR2 (cont.)

Dynamic limits
Measurement Data rate (MT/s) Min Max Units
tCH(abs) 0.45 0.55 –
tCL(abs) 0.45 0.55 –
tIPW 0.6 NA –
Vix(ac)CK 0.5*Vdd–0.175 0.5*Vdd+0.175 –
Vix(ac)DQS 0.5*Vdd–0.175 0.5*Vdd+0.175 –
Vox(ac)CK 0.5 * Vdd–0.125 0.5 x Vdd+0.125 –
Vox(ac)DQS 0.5 x Vdd–0.125 0.5 x Vdd+ 0.125 –
Vid(ac) 0.5 Vdd –

xxx

Dynamic Limits for DDR3 Measurements
The following table lists the dynamic limits for DDR3 measurements. For more details, refer to the DDR3
JEDEC standard specification mentioned in the application readme.txt.

NOTE. Dynamic limits are the same for all DDR3 data rates.

Table 17: Dynamic Limits for DDR3
Dynamic limits

Measurement Min Max Units
tCH(avg) 0.47 * tCK(avg) 0.53 * tCK(avg) tCK(avg)
tCL(avg) 0.47 * tCK(avg) 0.53 * tCK(avg) tCK(avg)
tCH(abs) 0.43 * tCK(avg) NA tCK(avg)
tCL(abs) 0.43 * tCK(avg) NA tCK(avg)
†tERR(13–50) (1 + 0.68ln(n)) *

tJIT(per)min
(1 + 0.68ln(n)) *
tJIT(per)max

–

xxx

† Includes measurements from tERR13per to tERR50per

Error Codes and Warnings
Code Description
E102 File does not exist.
E103 DPOJET is not able to open the help file. In order to use the help file, please reinstall

DPOJET.
E104 Mask Hits measurement requires an Eye diagram plot but no more plots can be

assigned. Please remove a plot before adding a Mask Hits measurement.

DDR Analysis 59



References Error Codes and Warnings

Code Description
E105 The maximum number of plots you can select is 4.
E106 No Spectrum plot data is available.
E202 The upper range must be greater than the lower range.
E400 A measurement failed to complete successfully.
W410 Number of edges are not sufficient for a measurement.
E411 In at least one zone, there are too few edges to complete a measurement.
E424 No edges or UI of the required type were found in the waveform. If this is not a clock

signal, check the Vref threshold and record length.
E425 No transitions of the selected Bit Type were found in the waveform.
E500 The record lengths of the source waveforms differ. Please configure for sources with

equivalent record lengths.
E1001 Vertical Autoset Failed: Signal on Source x has extreme offset.
E1002 Vertical Autoset Failed: Amplitude of Source x is too small.
E1003 Vertical Autoset Failed: Amplitude or DC offset of Source x is too high.
E1004 Vertical Autoset Failed: No signal on Source x.
E1005 Vertical Autoset Failed: Signal on Source x exceeds top of scale.
E1006 Vertical Autoset Failed: Signal on Source x exceeds bottom of scale.
E1007 Vertical Autoset Failed: Signal on Source x is clipped on top.
E1008 Vertical Autoset Failed: Signal on Source x is clipped on bottom.
E1009 Vertical Autoset Failed: Measurement error ( ISDB error code = 6 ) on Source x.
E1010 Vertical Autoset Failed: Measurement error ( ISDB error code = 7 ) on Source x.
W1011 A change to Source x vertical settings caused overload disconnect. Original settings

are restored and Source x is reconnected. Ignore oscilloscope message.
E1012 Vertical Autoset Failed: None of the selected measurements use live sources

(Ch1-Ch4). Horizontal autoset works for live sources only.
E1013 Vertical Autoset Failed: Invalid signal on Source x.
E1020 Horizontal Autoset Failed: None of the selected measurements use live sources

(Ch1-Ch4). Horizontal autoset works for live sources only.
E1021 Horizontal Autoset Failed: On Source x, cannot determine resolution of rising/falling

edges.
E1022 Horizontal Autoset Failed: Horizontal resolution is at the maximum.
E1035 Oscilloscope has gone into invalid state. Please restart the system.
E1040 Autoset Failed: None of the live sources (Ch1-Ch4) selected.
W1051 Ref Level Autoset: Waveform for the source x is clipped.
W1053 Ref Level Autoset: Source amplitude is extremely low.
E1054 Ref Level Autoset: Error in setting reference levels.
E1055 Ref Level Autoset Failed: No waveform to measure.
E1056 Ref Level Autoset: Unstable Histogram for waveform on source x.
E1057 Ref Level Autoset: No selected source.
E1058 Ref Level Autoset Failed: Invalid signal on source x.
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Code Description
E1059 Ref Level Autoset Error: Source x is not defined.
E2001 The maximum number of measurements has been reached.
E2002 All the refs are used as sources by the measurements. Export to Ref is not possible.
E2003 Ref ‘x’ is already used as a measurement source.
E2004 Ref ‘x’ is already used as a destination for other measurement.
E2005 No measurement(s) are selected. Export to Ref is not possible.
E2006 No results available to export to ref.
E2007 There are no time trend results for the selected measurement(s).
E2008 No ref destination is selected. Results will not be exported to ref.
E3001 Could not open or create a log file. Please ensure that you have read/write permission

to access log folders and files.
E3002 The specified path is invalid (for example: The specified path is not mapped to a drive).
E3003 The specified path, file name or both exceed the system defined length. For Example:

On Windows-based platforms, the path name must be less than 248 characters and file
names less than 260 characters.

E3004 The specified path directory is read-only or is not empty.
E3005 Please ensure that the file is currently not in use by other process and/or has not

exceeded the file size limit.
E3006 Invalid filename: Check whether the file name contains a colon (:) in the middle of

the string.
E3007 Select at least one measurement from the table before you save.
E3008 There are currently no results to save. Please run a measurement.
E3009 Current statistics is successfully saved at C:\TekApplications\DPOJET\Log\Statistics.
E3010 Access to file/directory denied. Please ensure that the file/directory has read/write

permissions.
E3011 Mask Hits Measurements will not be selected as this feature is not available for Mask

Hits measurement.
E3012 Folder does not exist.
E4000 Not enough data points. Unable to render plot(s).
E4001 Internal measurement error. Please remove a measurement and try again.
E4002 Not enough data points for spectrum computation.
E4003 Due to high memory usage, only a portion of the waveform could be processed. Please

reduce your record length or the number of measurements.
E4004 An error occurred in the edge extraction process.
E4005 Qualifier: The record length and sample interval must match across the waveforms.
E4006 A maximum of 4096 qualifier zones is supported. The entire waveform will not be

processed and hence partial measurement results are available.
E4007 Logic Qualifier enabled and no qualifier zones found.
W4008 The configured Ref voltage for Overshoot must be greater than or equal to the mid

autoset ref levels.
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Code Description
W4009 The configured Ref voltage for Undershoot must be lesser than or equal to the mid

autoset ref levels.
E9004 Derating will not be applied to the limits as Slew Rate measurements failed.
W9005 Derating value calculated using single Slew Rate measurement value.
W9006 Derating value cannot be computed since the calculated Slew Rate is not present in

the derating table †.
E9007 Derating Error *.
xxx

* Slew Rate measurements used to calculate the derated value failed to Run as there are no sufficient edges on the Rise and Fall slopes of
the waveform.

Base measurement limits are not defined as per the specification.
† Signal Slew Rate value is outside the derating table (Ex: If DDR2-800 MT/s tDS derating with a differential probe has a DQS differential slew rate of

0.65 V/ns, this warning message is displayed as the derating table definition starts from 0.8 V/ns).

Derating value is "not supported" (TBD) in the specification (Ex: If the DQS differential slew rate is 2.0 V/ns and the DQ slew rate is
0.7 V/ns, then the value is "-"(TBD).

Derating will not be applied for the above cases and the base limit will be displayed in the results table.
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About Algorithms
The DDRA application can take measurements by selecting either Clock, Strobe, Data or Chip Select as
sources. The number of waveforms used by the application depends on the type of measurement being
taken.

Oscilloscope Setup Guidelines
For all measurements, use the following guidelines to set up the oscilloscope:

The signal is any channel, reference, or math waveform.

The vertical scale for the waveform must be set so that the waveform does not exceed the vertical
range of the oscilloscope.

The sample rate must be set to capture sufficient waveform detail and avoid aliasing.

Longer record lengths increase measurement accuracy but the oscilloscope takes longer to measure
each waveform.

Search and Mark Algorithms
DDR search algorithms look for patterns in data (DQ) to determine start and end of bursts. All searches use
histogram analysis around edges found in the waveform, where edges are determined using the supplied
min/max/mid levels. These levels and the speed grade are configurable in the DDRA application’s first and
fifth steps.

DDR search operates by scanning through both DQ and DQS and measuring peak to peak voltage and
mid-levels. The mid-level detected on DQS is then used with a 10% hysteresis band to extract the edges
from the DQS signal. These edges are stored and are then used for bit rate estimation.

All DDR searches use waveform shape expectations to determine start or stop of a Read and Write burst.
The application will scan for first the start of any burst, followed by that burst’s termination condition. Once
a start condition has been found, only the termination condition will be searched for until the end-of-record.

Data Eye Width
Data Eye Width is common for both Read and Write bursts. The type of burst is determined by the ASM
settings. If a waveform contains multiple bursts of the same kind, the Data Eye Width is calculated and
respective Eye Diagram rendered for all bursts within one acquisition. It uses the DPOJET measurement,
Eye width with eye diagram plot enabled. Set DQ to Data signal and DQS to explicit clock edge.

If an explicit clock is used the DQS eye will be superimposed onto the Data Eye diagram. The
superimposed eye can be turned off from Eye diagram plot configuration panel. For Write bursts, the DQS
eye is offset from the Data eye (crossing in the center), whereas eye diagrams overlap for Read bursts. The
position of eye diagrams can be controlled using the Ref Clock alignment property on the Eye diagram
plot configuration panel. The left and center options indicate where the DQS crossing shall be located so
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that Data Eye will maintain its normal position. Left is suitable for Read bursts and center for Write bursts.
Use Auto to automatically determine the offset property.

For more details, refer to the topic “Eye Width” of the DPOJET help.

tDH-Diff(base)
tDH-Diff(base) is defined as the input hold time between Data (DQ) and Differential Strobe (DQS) signal.
It is the elapsed time taken from the mid-level of the DQS signal to the specific level (VIH(dc) and
VIL(dc), where VIH(dc) is on a falling slope of DQ signal and VIL(ac) is on a rising slope of the DQ
signal). This measurement requires you to set up correct reference levels for DQS and DQ signals for
different speeds. The DDRA application will set up these levels automatically when “JEDEC Default”
mode is selected. When “User Defined” mode is selected, then these reference levels are calculated
based on your input for Vref and Vdd.

tDH-Diff(base) uses the DPOJET measurement, DDR-Hold-Diff.

For more details, refer to the topic “DDR-Hold-Diff” of the DPOJET help.

tDH-Diff(derated)
Derating limits are calculated by adding the tDH(base) limit and ΔtDH(derating) value. ΔtDH for a
rising signal is defined as the slew rate between the last crossing of VIL(dc)max and the first crossing of
VREF(dc), and for a falling signal is defined as the slew rate between the last crossing of VIH(dc) min and
the first crossing of VREF(dc).

tDH-Diff(derated) uses the DPOJET measurement, DDR-Hold-Diff, to calculate the base value.

For more details, refer to the topic “DDR-Hold-Diff” of the DPOJET help.

tDS-Diff(derated)
Derating limits are calculated by adding the tDS(base) limit and ΔtDS(derating) value.. ΔtDS for a rising
signal is defined as the slew rate between the last crossing of VREF(dc) and the first crossing of VIH(ac)min, and
for a falling signal is defined as the slew rate between the last crossing of VREF(dc) and the first crossing
of VIL(ac)max and the first crossing of VIL(ac)max.

tDS-Diff(derated) uses the DPOJET measurement, DDR-Setup-Diff, to calculate the base value.

For more details, refer to the topic “DDR-Setup-Diff” of the DPOJET help.
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tDH-SE(base)
tDH-SE(base) is defined as the input hold time between DQ and single-ended DQS signal.

tDH-SE(base) uses the DPOJET measurement, DDR-Hold-SE.

For more details, refer to the topic “DDR-Hold-SE” of the DPOJET help.

Slew Rate-Hold-Fall(DQ)
Slew Rate-Hold-Fall(DQ) measures the slew rate on the DQ-SE signal between the falling edge from VREF
to VIL(ac)max. This measurement is available for both DDR2 and DDR3 generation.

Slew Rate-Hold-Fall(DQ) uses the DPOJET measurement, Fall Slew Rate.

For more details, refer to the topic “Fall Slew Rate” of the DPOJET help.

Slew Rate-Hold-SE-Fall(DQS)
Slew Rate-Hold-SE-Fall(DQS) measures the slew rate on the DQS-SE signal between the falling edge
from VREF to VIL(ac)max.

Slew Rate-Hold-SE-Fall(DQS) uses the DPOJET measurement, Fall Slew Rate.

For more details, refer to the topic “Fall Slew Rate” of the DPOJET help.

Slew Rate-Hold-Rise(DQ)
Slew Rate-Hold-Rise(DQ) measures the slew rate on the DQ-SE signal between the rising edge from VREF
to VIH(ac)min. This measurement is available for both DDR2 and DDR3 generation.

Slew Rate-Hold-Rise(DQ) uses the DPOJET measurement, Rise Slew Rate.

For more details, refer to the topic “Rise Slew Rate” of the DPOJET help.

Slew Rate-Hold-SE-Rise(DQS)
Slew Rate-Hold-SE-Rise(DQS) measures the slew rate on the DQS-SE signal between the rising edge
from VREF to VIH(ac)min.

Slew Rate-Hold-SE-Rise(DQS) uses the DPOJET measurement, Rise Slew Rate.
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For more details, refer to the topic “Rise Slew Rate” of the DPOJET help.

Slew Rate-Setup-Fall(DQ)
Slew Rate-Setup-Fall(DQ) measures the slew rate on the DQ-SE signal between the falling edge from VREF
to VIL(ac)max. This measurement is available for both DDR2 and DDR3 generation.

Slew Rate-Setup-Fall(DQ) uses the DPOJET measurement, Fall Slew Rate.

For more details, refer to the topic “Fall Slew Rate” of the DPOJET help.

Slew Rate-Setup-SE-Fall(DQS)
Slew Rate-Setup-SE-Fall(DQS) measures the slew rate on the DQS-SE signal between the falling edge
from VREF to VIL(ac)max.

Slew Rate-Setup-SE-Fall(DQS) uses the DPOJET measurement, Fall Slew Rate.

For more details, refer to the topic “Fall Slew Rate” of the DPOJET help.

Slew Rate-Setup-Rise(DQ)
Slew Rate-Setup-Rise(DQ) measures the slew rate on the DQ-SE signal between the rising edge from VREF
to VIH(ac)min. This measurement is available for both DDR2 and DDR3 generation.

Slew Rate-Setup-Rise(DQ) uses the DPOJET measurement, Rise Slew Rate.

For more details, refer to the topic “Rise Slew Rate” of the DPOJET help.

Slew Rate-Setup-SE-Rise(DQS)
Slew Rate-Setup-SE-Rise(DQS) measures the slew rate on the DQS-SE signal between the rising edge
from VREF to VIH(ac)min.

Slew Rate-Setup-SE-Rise(DQS) uses the DPOJET measurement, Rise Slew Rate.

For more details, refer to the topic “Rise Slew Rate” of the DPOJET help.
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tDS-Diff(base)
tDS-Diff(base) is defined as the input setup time between DQ and differential DQS signal. It is the elapsed
time taken from the mid-level of the DQS signal to the specific level (VIH(ac) and VIL(ac), where VIH(ac)
is on a falling slope of DQ signal and VIL(ac) is on a rising slope of the DQ signal).

tDS-Diff(base) uses the DPOJET measurement, DDR Setup-Diff.

For more details, refer to the topic “DDR-Setup-Diff” of the DPOJET help.

The configured values of Vdd and Vref are used to calculate VIH(ac)min VIH(dc)min, VIL(dc)max and VIL(ac)max,
which are applied on the input signal. These levels are further used for calculating Setup and Hold
measurements.

The relationship between Vdd and Vref for DDR2 standard is as shown in the following tables. For other
DDR standards, please refer to their JEDEC specifications.
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Table 18: Input DC logic Level
Symbol Parameter Min Max Units
VIH(dc) DC input logic high Vref+0.125 – V
VIL(dc) DC input logic low –0.3 Vref–0.125 V
xxx

Table 19: Input AC logic Level
DDR2–400, DDR2–533 DDR2–667,DDR2–800 Units

Symbol Parameter Min Max Min Max
VIH(ac) AC input

logic high
Vref+0.250 x Vref+0.200 – V

VIL(ac) AC input
logic low

– Vref–0.250 – Vref+0.200 V

xxx

tDS-SE(base)
tDS-SE(base) is the input setup time between DQ and single-ended DQS signal. It is the elapsed time
between VIH(dc)min of DQS and VIL(ac) max of DQ.

tDS-SE(base) uses the DPOJET measurement, DDR-Setup-SE.

For more details, refer to the topic “DDR-Setup-SE” of the DPOJET help.

tDQSH
tDQSH is the high pulse width on the DQS(Strobe) input. Amount of time the waveform remains above
the mid reference voltage level.

tDQSH uses the DPOJET measurement, Pos Width.

For more details, refer to the topic “Positive and Negative Width” of the DPOJET help.
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tDQSL
tDQSL is the low pulse width on the DQS(Strobe) input. Amount of time the waveform remains below the
mid reference voltage level.

tDQSL uses the DPOJET measurement, Neg Width.

For more details, refer to the topic “Positive and Negative Width” of the DPOJET help.

tDIPW-SE
tDIPW-SE is defined as the input pulse width on the DQ signal.

tDIPW-SE uses the DPOJET measurement, High Time.

For more details, refer to the topic “High Time” of the DPOJET help.

tDSS-Diff
tDSS-Diff is defined as the elapsed setup time from the DQS falling edge to the clock rising edge.

tDSS-Diff uses the DPOJET measurement, Skew.

For more details, refer to the topic “Skew” of the DPOJET help.

tDSS-SE
tDSS-SE is defined as the elapsed setup time from the DQS falling edge to the clock rising edge.

tDSS-SE uses the DPOJET measurement, Skew.

For more details, refer to the topic “Skew” of the DPOJET help.
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tDSH-Diff
tDSH-Diff is defined as the elapsed hold time from the DQS falling edge to the clock rising edge.

tDSH-Diff uses the DPOJET measurement, Hold.

For more details, refer to the topic “Hold” of the DPOJET help.

tDSH-SE
tDSH-SE is defined as the elapsed hold time from the DQS falling edge to the clock rising edge.

tDSH-SE uses the DPOJET measurement, Hold.

For more details, refer to the topic “Hold” of the DPOJET help.

tDQSS-Diff
tDQSS-Diff is defined as the elapsed time from the DQS rising edge to the clock rising edge.

tDQSS-Diff uses the DPOJET measurement, Setup.

For more details, refer to the topic “Setup” of the DPOJET help.

tDQSS-SE
tDQSS-SE is defined as the elapsed time from the DQS rising edge to the clock rising edge.

tDQSS-SE uses the DPOJET measurement, Setup.

For more details, refer to the topic “Setup” of the DPOJET help.

tDQSCK-Diff
tDQSCK-Diff is the DQS output access time from CK or CK#.

tDQSCK-Diff uses the DPOJET measurement, Skew.
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The application calculates this measurement using the following equation:

for mid level

Where:

Tn specifies the clock edges.

TDQS(n) specifies the DQS edges.

The edge locations are determined by the mid-reference voltage levels. This is a skew measurement
between the rising edge of DQS and the rising edge of clock.

For more details, refer to the topic “Skew” of the DPOJET help.

NOTE. The JEDEC standard specifies that tDQSCK is the actual position of a rising strobe edge relative
to CK, CK#. Hence, DQS should be in phase with CK. When DQS and CK are not in phase, there could
be possibility of probe polarity interchange. You can overcome this by changing the edge direction to
“Opposite as From” under edges configure tab for Skew measurements.

For more details, refer to the topic “Configuring Edges for Skew Measurement” of the DPOJET help.

tDQSQ-Diff
tDQSQ-Diff is the DQS-DQ skew for DQS and associated DQ signals. Set JEDEC standard reference
levels for DQ.

tDQSQ-Diff uses the DPOJET measurement, Setup.
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For more details, refer to the topic “Setup” of the DPOJET help.

tDQSQ-SE
tDQSQ-SE is the skew measured between DQS and DQ single-ended signals.

tDQSQ-SE uses the DPOJET measurement, Setup.

For more details, refer to the topic “Setup” of the DPOJET help.

tAC-Diff
tAC-Diff is the DQ output access time from CK or CK#. Set DQ as the clock source and DQS as the
differential source. Set appropriate reference levels for DQ.

tAC-Diff uses the DPOJET measurement, DDR-Setup-Diff.

For more details, refer to the topic “DDR-Setup-Diff” of the DPOJET help.

Input Slew-Diff-Rise(DQS)
Input Slew-Diff-Rise(DQS) measures slew rate on differential DQS signals between the rising edges
from low to high.

Input Slew-Diff-Rise(DQS) uses the DPOJET measurement, Rise Slew Rate.
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NOTE. The above figure is applicable for all DDR2 Slew Rate(Diff) measurements.

For more details, refer to the topic “Rise Slew Rate” of the DPOJET help.

Input Slew-Diff-Fall(DQS)
Input Slew-Diff-Fall(DQS) measures slew rate on differential DQS signals between the falling edges
from high to low.

Input Slew-Diff-Fall(DQS) uses the DPOJET measurement, Fall Slew Rate.

For more details, refer to the topic “Fall Slew Rate” of the DPOJET help.

Input Slew-Diff-Rise(CK)
Input Slew-Diff-Rise(CK) measures slew rate on differential CK signals between the rising edges from
low to high. The clock differential voltage varies from 500 mV to –250 mV.

Input Slew-Diff-Rise(CK) uses the DPOJET measurement, Rise Slew Rate.

For more details, refer to the topic “Rise Slew Rate” of the DPOJET help.
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Input Slew-Diff-Fall(CK)
Input Slew-Diff-Fall(CK) measures slew rate on differential CK signals between falling edges from clock
high to low. The clock differential voltage varies from +500 mV to –250 mV.

Input Slew-Diff-Fall(CK) uses the DPOJET measurement, Fall Slew Rate.

For more details, refer to the topic “Fall Slew Rate” of the DPOJET help.

SRQdiff-Rise(DQS)
SRQdiff-Rise(DQS) measures slew rate on differential DQS signals between the rising edges from low to
high.

SRQdiff-Rise(DQS) uses the DPOJET measurement, Rise Slew Rate.

NOTE. The above figure is applicable for all DDR3 Slew Rate(Diff) measurements.
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For more details, refer to the topic “Rise Slew Rate” of the DPOJET help.

SRQdiff-Fall(DQS)
SRQdiff-Fall(DQS) measures slew rate on differential DQS signals between the falling edges from high
to low.

SRQdiff-Fall(DQS) uses the DPOJET measurement, Fall Slew Rate.

For more details, refer to the topic “Fall Slew Rate” of the DPOJET help.

SRQdiff-Rise(CK)
SRQdiff-Rise(CK) measures the slew rate on differential CK signals between the rsisng edges from low to
high. As per the DDR3 specification, the clock differential value varies from +200 mV to –200 mV.

SRQdiff-Rise(CK) uses the DPOJET measurement, Rise Slew Rate.

For more details, refer to the topic “Rise Slew Rate” of the DPOJET help.

SRQdiff-Fall(CK)
SRQdiff-Fall(CK) measures the slew rate on differential CK signals between falling edges from high to
low. As per the DDR3 specification, the clock differential value varies from +200 mV to –200 mV.

SRQdiff-Fall(CK) uses the DPOJET measurement, Fall Slew Rate.

For more details, refer to the topic “Fall Slew Rate” of the DPOJET help.

tCH(abs)
tCH(abs) is the high pulse width on the clock signal. It is the amount of time the waveform remains
above the mid reference voltage level.

tCH(abs) uses the DPOJET measurement, Pos Width.
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For more details, refer to the topic “Positive and Negative Width” of the DPOJET help.

tCH(avg)
tCH(avg) is the average width of the high-half cycle calculated across a sliding 200-cycle window
of clock cycles.

tCH(avg) uses the DPOJET measurement, DDR tCH(avg).

The application calculates this measurement using the following equation:

Where:

N=200, which is configurable.

tCK(abs)
tCK(abs)is the absolute clock period. It is the elapsed time between consecutive rising crossings of the mid
reference CK voltage level.

tCK(abs) uses the DPOJET measurement, Period.

For more details, refer to the topic “Period” of the DPOJET help.

tCK(avg)
tCK(avg) is calculated as the average clock period across a sliding 200-cycle window of low pulses.

tCK(avg) uses the DPOJET measurement, DDR tCK(avg).

The application calculates this measurement using the following equation:

Where:
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N=200, which is configurable.

Range: 200≤N≤1M

tCL(abs)
tCL(abs) is the low pulse width on the clock signal. It is the amount of time the waveform remains
below the mid reference voltage level.

tCL(abs) uses the DPOJET measurement, Neg Width.

For more details, refer to the topic “Positive and Negative Width” of the DPOJET help.

tCL(avg)
tCL(avg) is defined as the average low pulse width calculated across 200-cycle window of consecutive
low pulses.

tCL(avg) uses the DPOJET measurement, DDR tCL(avg).

The application calculates this measurement using the following equation:

Where:

N=200, which is configurable.

Range: 200≤N≤1M

tHP
tHP is the minimum of the absolute half period of the actual input clock. It is similar to DPOJET’s Period
measurement where the edge type is clock with edges selection set to both. Only the minimum result
statistics will be compared with the limit values for PASS/FAIL status.

The application calculates this measurement using the following equation:
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Where:

tCH(abs) is the minimum of the actual instantaneous clock high time.

tCL(abs) is the minimum of the actual instantaneous clock low time.

tERR
tERR (Timing error) is the time difference between the sum of tCK transitions for a 200-cycle window to
n times tCK(avg). The calculated value represents the accumulated error across many cycles (n). The
number of cycles to be used is defined by n, which is configurable.

The application calculates this measurement using the following equation:

Where:

For tERR(nper):

n=2 for tERR(2 per)

n=3 for tERR(3 per)

n=4 for tERR(4 per)

n=5 for tERR(5 per)

n=6 for tERR(6 per)

.

.

.

.

n=49 for tERR(49 per)

For tERR(m-nper):

6 ≤ n ≤ 10 for tERR(6–10 per)

11 ≤ n ≤ 50 for tERR(11–50 per)

13 ≤ n ≤ 50 for tERR(13–50 per)
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tJIT(cc)
tJIT(cc) is the difference in period measurements from one cycle to the next; that is, the first difference
of the Period measurement.

tJIT(cc) uses the DPOJET measurement, CC–Period.

The application calculates this measurement using the following equation:

tJIT(duty)
tJIT(duty) is the largest elapsed time between the tCH from tCH(avg) or tCL from tCL(avg) for a 200-cycle
window. This value represents the maximum of the accumulated value across a 200-cycle moving window.

tJIT(duty) uses the DPOJET measurement, DDR tJIT(duty).

The application calculates this measurement using the following equation:

Where:

tJIT(CH) = {tCHi- tCH(avg)}

tJIT(CL) = {tCLi- tCL(avg)}

Where:

i=1 to 200

tJIT(per)
tJIT(per) is the largest elapsed time between the tCK from tCK(avg) for a 200-cycle window. This value
represents the maximum of the accumulated value across a 200-cycle moving window.

tJIT(per) uses the DPOJET measurement, DDR tJIT(per).

The application calculates this measurement using the following equation:
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Where:

i=1 to 200

VID(ac)
VID(ac) is defined as the magnitude of the difference between the input voltage on CK and the input
voltage on CK#.

VID(ac) uses the DPOJET measurement, High-Low.

For more details, refer to the topic “High Low” of the DPOJET help.

AC-Overshoot(CK)
AC-Overshoot(CK) is the positive-going amplitude, for each waveform event that exceeds the Vdd
reference level on the CK signal.

AC-Overshoot(CK) uses the DPOJET measurement, Overshoot.

NOTE. If the input waveform never exceeds Vdd, the measurement will return a population of 0 events.

For more details, refer to the topic “Overshoot” of the DPOJET help.

AC-Overshoot(CK#)
AC-Overshoot(CK#) is the positive-going amplitude, for each waveform event that exceeds the Vdd
reference level on the CK# signal.

AC-Overshoot(CK#) uses the DPOJET measurement, Overshoot.

NOTE. If the input waveform never exceeds Vdd, the measurement will return a population of 0 events.

For more details, refer to the topic “Overshoot” of the DPOJET help.

AC-Undershoot(CK)
AC-Undershoot(CK) is the negative-going amplitude (expressed as a positive number), for each waveform
event that goes below the Vss reference level on the CK signal.
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AC-Undershoot(CK) uses the DPOJET measurement, Undershoot.

NOTE. If the input waveform never goes below Vss, the measurement will return a population of 0 events.

For more details, refer to the topic “Undershoot” of the DPOJET help.

AC-Undershoot(CK#)
AC-Undershoot(CK#) is the negative-going amplitude (expressed as a positive number), for each
waveform event that goes below the Vss reference level on the CK# signal.

AC-Undershoot(CK#) uses the DPOJET measurement, Undershoot.

NOTE. If the input waveform never goes below Vss, the measurement will return a population of 0 events.

For more details, refer to the topic “Undershoot” of the DPOJET help.

Vix(ac)CK
Vix(ac)CK is defined as the cross-point voltage for differential input signals measured across the clock
signal.

Vix(ac)CK uses the DPOJET measurement, V–Diff–Xovr.

For more details, refer to the topic “V–Diff–Xovr” of the DPOJET help.

Vox(ac)CK
Vox(ac)CK is defined as the cross-point voltage for differential input signals measured across the clock
signal.

Vox(ac)CK uses the DPOJET measurement, V–Diff–Xovr.

For more details, refer to the topic “V–Diff–Xovr” of the DPOJET help.

Vix(ac)DQS
Vix(ac)DQS is defined as the cross-point voltage for differential input signals measured across the DQS
signal.
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Vix(ac)DQS uses the DPOJET measurement, V–Diff–Xovr.

For more details, refer to the topic “V–Diff–Xovr” of the DPOJET help.

Vox(ac)DQS
Vox(ac)DQS is defined as the cross-point voltage for differential input signals measured across the DQS
signal.

Vox(ac)DQS uses the DPOJET measurement, V–Diff–Xovr.

For more details, refer to the topic “V–Diff–Xovr” of the DPOJET help.

AC-Overshoot(DQS)
AC-Overshoot(DQS) is the positive-going amplitude, for each waveform event that exceeds the Vdd
reference voltage level on the DQS signal.

AC-Overshoot(DQS) uses the DPOJET measurement, Overshoot.

NOTE. If the input waveform never exceeds the specified reference level, the measurement will return a
population of 0 events.

For more details, refer to the topic “Overshoot” of the DPOJET help.

AC-Overshoot(DQS#)
AC-Overshoot(DQS#) is the positive-going amplitude, for each waveform event that exceeds the Vdd
reference level on the DQS# signal.

AC-Overshoot(DQS#) uses the DPOJET measurement, Overshoot.

NOTE. If the input waveform never exceeds the specified reference level, the measurement will return a
population of 0 events.

For more details, refer to the topic “Overshoot” of the DPOJET help.
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AC-Undershoot(DQS)
AC-Undershoot(DQS) is the negative-going amplitude (expressed as a positive number), for each
waveform event that goes below the Vss reference level on the DQS signal.

AC-Undershoot(DQS) uses the DPOJET measurement, Undershoot.

NOTE. If the input waveform never goes below the specified reference level, the measurement will return a
population of 0 events.

For more details, refer to the topic “Undershoot” of the DPOJET help.

AC-Undershoot(DQS#)
AC-Undershoot(DQS#) is the negative-going amplitude (expressed as a positive number), for each
waveform event that goes below the reference level on the DQS# signal.

AC-Undershoot(DQS#) uses the DPOJET measurement, Undershoot.

NOTE. If the input waveform never goes below the specified reference level, the measurement will return a
population of 0 events.

For more details, refer to the topic “Undershoot” of the DPOJET help.

tIS(base)
tIS(base) is the input setup time measured on an address and command signal to the clock signal.

tIS(base) uses the DPOJET measurement, DDR Setup-Diff.

For more details, refer to the topic “DDR-Setup-Diff” of the DPOJET help.

tIH(base)
tIH(base) is the input hold time measured on an address and command signal to the clock signal.

tIH(base) uses the DPOJET measurement, DDR Hold-Diff.

For more details, refer to the topic “DDR Hold-Diff” of the DPOJET help.
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tIS(derated)
Derating limits are calculated by adding the tIS(base) limit and ΔtIS(derating) value. ΔtIS for a rising
signal is defined as the slew rate between the last crossing of VREF(dc) and the first crossing of VIH(ac)min,
and for a falling signal is defined as the slew rate between the last crossing of VREF(dc) and the first
crossing of Vil(ac)max.

tIS(derated) uses the DPOJET measurement, DDR Setup-Diff.

tIS= tIS(base)+ΔtIS

For more details, refer to the topic “DDR-Setup-Diff” of the DPOJET help.

tIH(derated)
Derating limits are calculated by adding the tIH(base) limit and ΔtIH(derating) value. ΔtIH for a rising
signal is defined as the slew rate between the last crossing of VIL(dc)max and the first crossing of VREF(dc),
and for a falling signal is defined as the slew rate between the last crossing of VIH(dc)min and the first
crossing of VREF(dc).

tIH(derated) uses the DPOJET measurement, DDR Hold-Diff.

For more details, refer to the topic “DDR-Hold-Diff” of the DPOJET help.

AC-Overshoot
AC-Overshoot is the maximum positive-going amplitude relative to Vdd, for each waveform event that
exceeds the Vdd reference voltage level.

AC-Overshoot uses the DPOJET measurement, Overshoot.
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AC-Undershoot
AC-Undershoot is the negative-going amplitude (expressed as a positive number) relative to Vss, for each
waveform event that goes below the Vss reference voltage level.

AC-Undershoot uses the DPOJET measurement, Undershoot.

tIPW-High
tIPW-High is the high input pulse width measured on an address and command signal.

tIPW-High uses the DPOJET measurement, High Time.

For more details, refer to the topic “High Time” of the DPOJET help.

tIPW-Low
tIPW-Low is the low input pulse width measured on an address and command signal.

tIPW-Low uses the DPOJET measurement, Low Time.

For more details, refer to the topic “Low Time” of the DPOJET help.
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